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1 Safety Information

Before starting installation, setting up, operation and before 
maintenance work is carried out, it is essential to read and follow 
the appropriate warning and safety information given in this 
manual.

Installation, setting up, operation and maintenance of the mod-
ules or devices must take place as intended, i.e. under the condi-
tions of use laid down in this manual and in the technical data for 
the relevant module or device.

1.1 Intended use

The products in the Q.series range are intended for use in indus-
trial and experimental test engineering and for monitoring 
assembly and production processes. Transducers (sensors) for 
the acquisition of physical quantities such as voltage, current, 
resistance, temperature, force, displacement, torque, mass, 
strain and pressure can be connected. The modules are used 
exclusively for these kinds of measurement and control applica-
tions. Any application which goes beyond this scope does not fall 
within the intended use of the modules.

To ensure safe operation the modules and devices must only be 
operated according to the details given in the manuals and tech-
nical data sheets. In addition, the required legal and safety regu-
lations covering the respective application must be followed. This 
applies in particular to the modules A123, A124, A127 and A128 
with which input voltages of up to 1200 VDC are possible.

1.2 Checking for damage in transit

On receipt of the goods visually check that the packaging and the 
module or device together with the data medium are intact. Also 
check the shipment for completeness (accessory parts, documen-
tation, auxiliary aids, etc.). If the packaging has been damaged in 
transit or if you suspect that the product is damaged or may mal-
function, the product must not be put into operation. In this case 
contact your customer consultant or Gantner Instruments GmbH.

1.3 Personnel

The installation, operation and maintenance of the modules or 
devices must only be carried out by competent persons. Compe-
tent persons are those who through their professional education 
have sufficient knowledge in the required field and are familiar 
with the relevant national occupational protection regulations, 
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accident prevention regulations, guidelines and accepted engi-
neering rules. They must be able to reliably assess the results of 
their work and must be familiar with the contents of this manual.

Electrical connections must only be carried out by specialist per-
sonnel trained for the task.

In particular, pay attention to the following:

• the national installation and erection regulations (e.g. ÖVE, 
VDE, etc.)

• generally accepted engineering rules

• the details on transport, installation, operation, servicing, 
maintenance and disposal in this manual.

• the parameters, limits and the details about the operating and 
ambient conditions on the name-plates and in the data sheets.

1.4 Special risks

The modules A123, A124, A127 and A128 are specifically 
intended for measurements at high voltages. Consequently, on 
the modules a voltage of up to 1200 V may be present, which can 
lead to fatal or severe injury on touching the terminal contacts or 
bare parts of the connecting cables. Therefore, make sure that 
only qualified personnel have access to the modules or devices 
and that the voltages on modules can be switched off by a switch-
disconnector or similar device for service purposes.

1.5 Siting locations

The devices in the Q.series range are protected to IP 20 against 
water, dirt and small parts. If the ambient conditions require it, 
the modules can be fitted in water-protected or watertight hous-
ings.

Please note the admissible ambient temperatures specified in the 
technical data.

1.6 Modifications

Making modifications to the modules or devices is not permitted. 
Dirt and shrouding covers may only be removed for service and 
maintenance purposes.

1.7 Servicing and cleaning

The modules or devices do not need any servicing. Cleaning may 
only take place in the voltage-free state. Therefore follow the 
points below:
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• Before cleaning, disconnect all connectors.

• Clean the housing with a soft, slightly moistened cloth. Never 
use any solvents, because these may attack the labels.

• When cleaning, make sure that no liquid enters into the 
device or goes onto the terminals.

Never attempt to repair nor to again operate devices which are 
defective, have developed a fault or are damaged. In this case it 
is essential to contact your customer consultant or Gantner 
Instruments GmbH.

1.8 Disposal

Old devices which are no longer usable must be disposed of 
according to national and local regulations regarding environ-
mental protection and raw-material recycling. Electronic compo-
nents must not be disposed of with the household refuse. The 
packaging can be recycled and should therefore be passed into 
the recycling system. However, we recommend that the packag-
ing is kept until the end of the warranty period so that you can 
pack faulty devices or modules properly.

1.9 General hazards due to non-observance of the 
safety information

The modules or devices conform to the state of the art and are 
operationally safe. However residual risks may arise when they 
are used and operated improperly by untrained personnel.

Any person commissioned with the task of siting, operating, ser-
vicing or repairing a module or device in the Q.series must have 
read and understood the operating manual and in particular the 
information relating to safety.
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2 Labels and warning infor-
mation

2.1 Warning information

To prevent personal injury and damage to property it is essential 
that you follow the warning and safety information given in this 
operating manual.

Indicates a directly threatening hazard. If it is not pre-
vented, the consequence will be fatal or serious injuries.

Indicates a possibly hazardous situation. If it is not prevented, the 
consequence may be fatal or serious injuries.

Indicates a possibly hazardous situation. If it is not prevented, the 
consequence may be injuries of slight or medium severity.

Indicates a situation in which the consequence may be property 
damage if the information is not followed.

2.2 Labels on the modules

Symbol: 

Meaning: This symbol is the CE marking. This shows that we 
guarantee that our product meets the requirements of the rele-
vant EC directives.

Symbol:  CAT I, CAT II, CAT III

Meaning: Modules with this symbol are intended for the connec-
tion of high voltage. The maximum admissible voltage is also 
given.

Symbol: 

Meaning: High voltage may be present on the module connec-
tions. Connection may only be made with the insulated connect-
ing plugs provided.
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2.3 Labels in this manual

To simplify reading this manual we use – along with the warning 
information given above – the following labels and notation:

IMPORTANT
Paragraphs with this symbol give important information about 
the product or about using the product.

Tip
Contains application hints and other particularly useful informa-
tion.

Symbol: 

Meaning: Before connecting or disconnecting cables make sure 
that all sources of power are Locked Out.

italics signifies highlighted text

interface signifies entries and entry fields in program 
user interfaces

Options indicates menu items in the program user 
interfaces

> signifies a sequence of menu items, e.g. in 
Options > Settings

➡ indicates special features or restrictions
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3 Introduction
 Dear Customer,

Thank you for purchasing a product in the Q.series from Gantner 
Instruments GmbH. We are sure that you have obtained an excel-
lent product which will enable you to make fast and reliable mea-
surements with low measurement uncertainties.

If you find faults on the product or errors in the accompanying 
documentation or if you have suggestions for improvement, 
please contact your customer consultant or Gantner Instruments 
GmbH directly. We would be glad to receive your comments and 
ideas.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
sections are open to the public).
 

Austria Gantner Instruments GmbH

Montafonerstr. 4

6780 Schruns/Austria

Tel.: +43 (0) 55 56 774 63-0
Fax: +43 (0) 55 56 774 63-300

E-mail: office@gantner-instruments.com
Web: www.gantner-instruments.com

Germany Gantner Instruments Test & Measurement GmbH

Heidelberger Landstr. 74

64297 Darmstadt

Tel.: +49 (0) 6151 95136-0
Fax: +49 (0) 6151 95136-26

E-mail: testing@gantner-instruments.com
Web: www.gantner-instruments.com
 

https://dev.gantner-instruments.com/dokuwiki
https://dev.gantner-instruments.com/dokuwiki
mailto:office@gantner-instruments.com
http://www.gantner-instruments.com
mailto:testing@gantner-instruments.com
http://www.gantner-instruments.com
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3.1 The documentation in the Q.bloxx range

The documentation for the Q.bloxx consists of this manual about 
the Q.bloxx modules A101, A102, A103, A104, A105, A106, A107, 
A108, A109, A111, A116, A123, A124, A127, A128, D101, D104, 
D105 and D107 as well as the Test Controllers Q.gate and Q.pac. 
Detailed descriptions on special settings for Q.gate and Q.pac or 
Q.station 101 can be found in other Gantner Instruments GmbH 
documentation on the Gantner CD or on our home page 
www.gantner-instruments.com.

You will find this manual also as a PDF file on our home page and 
on the Gantner CD enclosed with your module or which you can 
order free of charge from Gantner Instruments GmbH.

3.2 About this manual

This manual describes the installation, initial operation and the 
configuration of the modules Q.bloxx A101, A102, A103, A104, 
A105, A106, A107, A108, A109, A111, A116, A123, A124, A127, 
A128, D101, D104, D105 and D107 with the Test Controllers 
Q.gate and Q.pac using the program test.commander. The mod-
ules are differentiated through the number of their analog and/or 
digital inputs and outputs, by the maximum possible sample rate 
and the admissible input voltages.

The manual is divided into several chapters:

• Safety information in Chapter 1, ff. page 9.

• A description of the labels and symbols used on the modules 
and in this documentation can be found in Chapter 2 from 
page 13 onwards.

• You will find a description of the system and the main combi-
nation and expansion options in the next section.

• The description of the connection variants and the pin assign-
ments on the inputs and outputs can be found in Chapter 4, 
Connecting the modules, ff. page 21.

• A comprehensive introduction to the configuration of the 
modules using the program test.commander is given in 
Chapter 5, Configuration, ff. page 101.

• Comprehensive explanation of the module measurement tech-
nology and background information about working proce-
dures can be found in Chapter 6, Functional Procedures, ff. 
page 135.

http://www.gantner-instruments.com
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3.3 System description

The modules in the Q.bloxx series have been developed for indus-
trial and experimental measurement and test engineering, in par-
ticular for multi-channel measurements of electrical, mechanical 
and thermal signals on engine and component test-rigs as well as 
for monitoring processes and long-term supervision. The modules 
A123, A124, A127 and A128 are specially designed for measure-
ments at high voltages.

Voltages of up to 1200 V may be present on the connec-
tions of the modules A123, A124, A127 and A128.

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The individual modules can be combined to form one system as 
required. You can connect up to 32 or 64 modules to one of the 
Test Controllers Q.gate, Q.pac  or Q.station 101 and then address 
them from a PC or PLC via a single interface. Alternatively, it is 
also possible to address single modules directly via the serial 
interface.

On all modules the power supply, bus interface and the inputs 
and outputs are electrically isolated from one another. The use 
with Q.gate and Q.pac is explained in this manual. Please use the 
manual provided specifically for this module when operating the 
Test Controller Q.station 101.

3.3.1 Operating the modules via Q.gate

You can connect up to 16 modules to each of the two serial inter-
faces (UARTs) of the Q.gate Test Controller (Fig. 3-1 and Fig. 3-
2). For a direct connection on DIN mounting rails (DIN 35 mm 
rail according to DIN EN 60715) a special plug-on socket is also 
available: the Q.bloxx Extension Socket QES. This means that you 
can plug all 32 modules onto a mounting rail directly adjacent to 
one another. The Q.bloxx Extension Socket QES is plugged in 
centrally between the other sockets; the power supply of the sec-
ond group of up to 16 modules also takes place through the 
extension socket.

You can communicate via Ethernet with the connected modules 
from the Q.gate Test Controller. The maximum cable length 
between the measurement modules and the Q.gate depends on 
the desired baud rate:
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You can insert the Q.gate Test Controller alternatively into the 
base to the left or right of the Q.bloxx modules (first or last base). 
Since the Q.gate Test Controller has a bus termination, it must be 
located on the end of the line and must not be positioned between 
the modules.

Fig. 3-1 Q.gate with up to 32 modules, connection via base and 
Q.bloxx Extension Socket QES.

Fig. 3-2 Q.gate with up to 32 modules, connection via cables.

Cable length in meters Maximum baud rate

1000 < 500 kBaud

100 < 1500 kBaud

20 < 6000 kBaud

10 >6 to 24 MBaud

… …

max. 16 modulesmax. 16 modules

Extension Socket QESQ.gate

…

…

max. 16 modules each
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Depending on the operating mode of the modules, transmission 
rates of 1 kHz with up to 128 variables (transferred values with 
four byte resolution, real variables) are possible over Ethernet.

3.3.2 Operating the modules via Q.pac

The Q.pac Test Controller is a programmable module with its own 
128 Mbyte flash data memory and in addition it offers a graphi-
cally programmable PAC function. Optionally, EtherCAT is avail-
able as an additional interface with a data rate of up to 10 kHz.

You can connect up to 16 modules to each of the four serial inter-
faces (UARTs) of the Q.pac Test Controller (Fig. 3-3, page 20). 

When using Ethernet, with Q.pac you can realize up to 16 vari-
ables (transferred values with four-byte resolution, real variable) 
at a sample rate of 10 kHz and with EtherCAT even 256 variables 
are possible at the same sample rate:

UART data throughput at 24 MBaud

Sample rate 1 kHz

Sample rate 10 kHz

Sample rate 100 kHz

200 real variables

20 real variables

2 real variables

Ethernet data throughput (transmission rate with block transfer)
128 real variables (1 kHz)

16 real variables (10 kHz)

Ethernet data throughput (transmission rate with online transfer) 64 real variables (300 Hz)

Interfaces
Ethernet, USB, RS-232, 
2 UARTs

Max. number of slaves (Q.bloxx) 32

UART data throughput at 24 MBaud

Sample rate 1 kHz

Sample rate 10 kHz

Sample rate 100 kHz

200 real variables

20 real variables

2 real variables

Ethernet data throughput (transmission rate with block transfer)
128 real variables (1 kHz)

16 real variables (10 kHz)

Ethernet data throughput (transmission rate with online transfer) 128 real variables (300 Hz)

EtherCAT data throughput (transmission rate) 256 real variables (10 kHz)

Interfaces
Ethernet, EtherCAT, USB, 
RS-232, 4 UARTs

Max. number of slaves (Q.bloxx) 64
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Fig. 3-3 Q.pac with up to 64 modules.

3.3.3 Operating the modules without Test Controller

You can connect the modules directly to a PC or PLC via the RS-
485 interface on the modules. The following protocols are avail-
able:

• Gantner's own fast binary protocol. The configuration here 
takes place via the programs test.commander or ICP 100.

• Modbus RTU for reading and writing variables via registers.

• ASCII for reading and writing variables (values) with simple 
commands. Module configuration using the ASCII protocol is 
not possible.

…

…

…

…

max. 16 modules per UART



Q.series
Gantner Instruments GmbH 21

4     Connecting the modules → Connecting the base

4 Connecting the modules

This chapter contains the description of the connection variants 
and pin assignments.

4.1 Connecting the base

The base is used for supplying the current and voltage to the 
module, for synchronization and for the transfer of data. The 
module is also electrically connected to the mounting rail (DIN 
35 mm rail according to DIN EN 60715) by means of a metal 
spring in the base. In addition, you can activate the terminating 
resistances for the interface at the end of the cable, save the 
module configuration in the base and define the restoration of 
this configuration when inserting a new module.

First, set the DIP switches in the base to the required position 
(4.1.2 to 4.1.3). Then plug the base on and push on further bases 
from the right (4.1.4). The power is supplied from the left side 
which also provides a direct connection to the PC or PLC if you 
are not using any Q.gate or Q.pac.

IMPORTANT
The end of the interface line must be terminated with two resis-
tances. Otherwise reflections occur on the line and lead to distur-
bances, even to the loss of data transmission. Refer to 
Section 4.1.3, Activating the terminating resistances, page 24.

You can operate the bases in various modes:

• Unconfigured, i.e. the modules are fully configured via a PC 
and software.

• With address configuration, i.e. the address of the modules is 
set via the base and all the rest of the configuration takes 
place via a PC. An address set by software is not taken into 
account in this case.

• With boot configuration (factory setting), i.e. a module can be 
replaced at any time by one of the same type (hot swap). The 
configuration data are saved in the base and are automati-
cally loaded into the module when it is inserted. This means 
you can continue with your measurement without further con-
figuration work. Saving the necessary data in the base occurs 
automatically via the configuration software test.commander.

Configuring the operating 

mode

The configuration of the operating mode occurs using the DIP 
switches in the base (Fig. 4-1). DIP switch 7 is currently not 
assigned any function and is reserved for later expansions.
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Fig. 4-1 DIP switches in the base, all DIP switches except the first 
one are OFF (address 1, hot swap activated).

4.1.1 Hot swap (factory setting)

Hot swap, i.e. the loading of the configuration from the socket 
EPROM (boot configuration), enables you to replace a defective 
module by one of the same type without having to carry out a con-
figuration.

IMPORTANT
If hot swap is activated (factory setting), any data in the module 
may be overwritten during insertion without prior confirmation.

If the socket contains no configuration or an incorrect module 
type is plugged onto the socket which does not match the stored 
configuration, this module flashes SOS:

Fig. 4-2 Flashing sequence with an incorrect module or when 
there are no settings in the socket. A short dash corre-
sponds to a short flash, a long dash corresponds to a long 
flash.

After loading a valid configuration with the test.commander the 
module is ready for measurement and the configuration is also 
automatically set in the socket. During the next module replace-

ON

OFF
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ment the (new) module then reads the configuration from the 
socket EPROM and adjusts appropriately.

Tip
With hot swap activated you should also set the address via the 
base (Section 4.1.2).

Push the DIP switch 8 upwards (ON, refer also to Fig. 4-1 on 
page 22) to deactivate hot swap. Any content present in the 
EPROM is not read in this case and the module configuration is 
used. After plug-in – once the module excitation is present – the 
module configuration is automatically transferred into the socket 
and saved, so that the same configuration is present in the socket 
as in the module.

Transferring the configuration to the base

When the configuration is changed via the test.commander pro-
gram, the new configuration is automatically transferred to the 
base. In this way it is ensured that the same configuration is 
always present both in the base and in the module.

Replacing bases

1. You deactivate hot swap in the new socket as follows: Push 
DIP switch 8 upwards (ON).

2. Mount the new socket (Section 4.1.4, page 25) and switch the 
supply voltage on again.

3. Plug in the (old) module.

The module configuration is automatically transferred to the 
new socket (flashing LEDs). 

4. Wait until the loading process has finished, i.e. until the LEDs 
no longer flash. 

5. Withdraw the module again (Fig. 4-7, page 30).

6. Push DIP switch 8 downwards again to (OFF).

Next time the module is plugged in, the data will then be read 
from the socket again.

4.1.2 Setting the address (optional)

The address is set in binary form with the first six switches. The 
address 0 corresponds to no configuration, i.e. an inserted mod-
ule retains the address assigned via software. With new modules 
fresh from the factory you always have to assign an address, 
either via the DIP switch or via software, because otherwise sev-
eral modules use the same address (default: 1) and are therefore 
not capable of measurement within a data bus; refer to 
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Chapter 5, Configuration, Section 5.2. Also for a configuration 
via the DIP switches an address set via the PC is retained in the 
module and is used again when the DIP switches are set to the 
address 0.

1) OFF = Switch down, ON = Switch up (Fig. 4-1)

The addresses 33 to 63 cannot be used via Q.gate or Q.pac. They 
are only available with the direct connection of a PC or a PLC; 
refer also to Section 4.4.5, Connecting modules directly to a PC/
PLC.

➡ A base which is used to accommodate a Q.gate Test Controller 
requires no address.

4.1.3 Activating the terminating resistances

The terminating resistances must be activated on the last base of 
each interface line (and only there), because the end of the line 
must be terminated with two resistors (termination). Otherwise 
reflections occur on the line and lead to disturbances, even to the 
loss of data transmission.

➡ If the base is intended for accepting a Q.gate module, the termi-
nating resistances must not be activated, because this module 
contains its own resistances.

• Push the DIP switches 9 and 10 upwards to activate the termi-
nating resistances (refer to Fig. 4-1 on page 22).

The resistances are only activated for the lines of UART 1A and 
UART 1B, because it is only these lines which are used by the 
modules. The lines for UART 2A and UART 2B are just passed on 

Address S1 S2 S3 S4 S5 S6

0 OFF1 OFF OFF OFF OFF OFF

1 ON1 OFF OFF OFF OFF OFF

2 OFF ON OFF OFF OFF OFF

3 ON ON OFF OFF OFF OFF

4 OFF OFF ON OFF OFF OFF

5 ON OFF ON OFF OFF OFF

… … … … … … …

30 OFF ON ON ON ON OFF

31 ON ON ON ON ON OFF

32 OFF OFF OFF OFF OFF ON
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by the bases and not used by the modules, so no terminating 
resistance is needed (no termination).

IMPORTANT
The terminating resistances may only be activated at the end 
points of the interface line. If resistances are also activated in 
between, the signal is weakened and interference or even inter-
ruption of the data transmission occurs for the modules located 
after the additional resistances.

Terminating resistances and Q.bloxx Extension Socket QES

If you are using the Q.bloxx Extension Socket QES and have acti-
vated the bus crossover, you must activate the DIP switches in 
the socket directly before the extension socket and in the last 
socket after the extension socket (as viewed from the interface 
connection to the controller). In the socket before the extension 
socket the termination is made for the lines UART 1A and 
UART 1B which are then not used further. After the extension 
socket, due to the bus crossover, the lines for UART 2A and 
UART 2B, which were only routed further by the previous sock-
ets, are located on the lines for UART 1A and UART 1B and are 
used for communication by the inserted modules. The termina-
tion must therefore occur at the end of the line in the last socket 
after the extension socket.
Refer also to Section 4.1.5, Q.bloxx Extension Socket QES, 
page 26.

4.1.4 Mounting/removing bases

➡ We recommend that the socket is only connected to the power 
supply after mounting (Section 4.2, page 28).

You can clip the base directly onto mounting rails (35 mm DIN 
rail according to DIN EN 60715): Hang the base over the upper 
part of the rail and then press it downwards until the latching 
cam locks in.

Then push the base onto any further existing bases to the left. 
There should be no intervening space between the bases, so 
press the right base firmly onto the left one.
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Fig. 4-3 Connecting several bases.

To remove, insert a narrow screwdriver into the hole at the lower 
end, press the screwdriver upwards on the handle to push the 
metal clip in the latching cam downwards and from below pull 
the base from the mounting rail to the front.

4.1.5 Q.bloxx Extension Socket QES

If you want to connect more than 16 modules, need a further feed 
for the supply voltage or want to spread modules over two bus 
interfaces, you need the Q.bloxx Extension Socket QES; modules 
inserted into the sockets only use the lines of UART 1. Since a 
maximum of 16 modules per bus interface is possible, with more 
modules you have to use UART 1 and UART 2. 

With the extension socket you can additionally connect the mod-
ules arranged to the right of the socket to the lines of UART 2, i.e. 
the module crosses the lines of the two UARTs: The lines from 
UART 1 on the left side then go to the lines of UART 2 on the 
right side where they remain unused. The lines from UART 2 on 
the left side go to the lines of UART 1 on the right side and are 
used by the modules. Both UART interfaces are accessible via the 
extension socket and via the plug on the socket on the far left.

➡ All modules to the right of the extension socket can only be con-
nected to the power supply via the plug in the extension socket, 
since there is no connection to the modules on the left side. All 
modules to the left of the extension socket must be supplied via 
the socket on the far left.

Using less than 16 modules

In this way you can use the Q.bloxx Extension Socket QES to
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1. Obtain another feed point for the supply voltage.

2. Operate the modules with two interfaces in order to increase 
the data throughput.

The modules situated on the right of the extension socket are 
supplied by the extension socket and the modules located to the 
left must be supplied via the socket on the far left. 

Crossing the UART lines is only necessary in the second case. The 
factory setting of the DIP switches is the 1:1 connection (i.e. with 
the interface lines directly connected), but check the setting of 
the DIP switches just to be sure.

Using more than 16 modules

The power supply must be routed via the socket situated on the 
far left as well as via the extension socket. The pin assignment is 
identical to the pin assignment for the side connection (Fig. 4-6, 
page 29). The DIP switches should be set to the crossover mode. 
You have four possible ways of connecting the interfaces.

1. You can use the connection on the socket on the far left.

In this way you can connect both interfaces if you interchange 
(cross) the UART lines via the DIP switches on the extension 
socket. This variant is, for example, suitable for the connec-
tion of a Q.pac Test Controller.

2. You can use a Q.gate Test Controller.

Plug the Q.gate Test Controller into the socket on the far left 
or far right and cross the UART lines using the DIP switches 
on the extension socket. The Test Controller then uses both 
UARTs for communication with the modules.

3. You connect the interface of UART 1 via a cable on the left 
socket and the interface of UART 2 on the Q.bloxx Extension 
Socket QES.

Also in this case you must cross the UART lines via the DIP 
switches on the extension socket, because the modules only 
use the lines of UART 1.

4. You connect both interfaces via cable to the Q.bloxx Exten-
sion Socket QES.

In this way you can connect both interfaces if you interchange 
(cross) the UART lines via the DIP switches on the extension 
socket. This variant is, for example, suitable for the connec-
tion of a Q.pac Test Controller.

DIP switch settings

The extension socket is operated in one of two modes depending 
on the application:
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1. The interface lines are connected through 1:1 from left to 
right.

The DIP switches 1 to 4 are OFF and the DIP switches 5 to 8 
are ON (factory setting).

2. The interface lines are crossed.

The DIP switches 1 to 4 are ON and the DIP switches 5 to 8 
are OFF.

The DIP switches 9 and 10 (far right) have no function so their 
settings do not matter. 

➡ Setting of all switches to OFF or all switches to ON is not admis-
sible.

Fig. 4-4 The DIP switch position for a 1:1 connection (factory set-
ting).

Fig. 4-5 The DIP switch position for crossed connection (interface 
lines for UART 1 and UART 2 are crossed).

4.2 Connecting the power supply

For the power supply an unregulated direct voltage between 10 
and 30 volts is required, which is connected to the contacts 5 and 
6 from above the base. Fig. 4-6 shows the pin assignment. Each 
module requires a power of approx. 2 W in addition to the power 
supplied for the connected transducers. The power required is 
almost constant over the complete voltage range.

1 OFF

1 OFF
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Fig. 4-6 Assignment for the base socket contacts (plan view).

IMPORTANT
When the modules are switched on, there is an increase current 
demand until the modules are operating in a stable manner: In 
the start-up phase up to 700 mA (10 ms) per module is needed 
depending on the supply voltage. Thereafter, you should expect 
approx. 500 mA per module for a 10 V supply voltage, with a 30 V 
supply voltage approx. 170 mA. You should therefore either use 
power supplies which can deliver the required peak power when 
the voltage is switched on or – with many modules – switch the 
modules on in several groups.

The modules have an internal self-healing (reversible) fuse for 
protection against overvoltages, overcurrents and incorrect 
polarity. 

➡ Do not use cable which is too thin for the connection so that the 
required power can be transferred to the module without signifi-
cant losses. 

The cable diameter, which can be connected to the terminals, is 

0.14 mm2 minimum and 1.5 mm2 maximum or with wire-end 

sleeves without plastic sleeves 0.25 mm2 and 1.5 mm2 and with 

plastic sleeves between 0.25 mm2 and 0.5 mm2. In total no more 
than 16 modules should be supplied through their bases con-
nected together. With more modules another supply line is neces-
sary, for example via the Q.bloxx Extension Socket QES.

➡ The extension socket only supplies the module situated to the 
right of it and the modules located to the left of it require a power 
supply via the socket located on the far left.

Pin assignment

Sync A

UART 2B

UART 2A

Sync B

Supply +10 to 30 VDC

Supply 0 V

UART 1B

UART 1A
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4.3 Fitting and removal of modules from bases

Once you have mounted the bases, you can plug in the modules. 
To do this, hold the module so that it latches into the base latch-
ing cam below and then press it into the base with a slight rotary 
movement until the upper latching cam locks. Then press the 
orange-colored clip downwards (press lightly on the clip from 
above) to lock the module. Finally, check again that the module is 
correctly latched in the lower latching cam.

To remove a module from the base insert a narrow screwdriver 
through the hole in the upper latching cam and press the orange-
colored clip in the latching cam upwards by pressing the screw-
driver downwards (Fig. 4-7). Pull the module out to the front and 
downwards with a slight rotary movement.

Fig. 4-7 Removal of a module from the base.
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4.4 Connecting interfaces

You have several options for communicating (configuration and 
data interchange) with the modules. You can:

• Connect the modules first to a Q.gate or Q.pac (Section 4.4.1 
and Section 4.4.2, from page 31 onwards) and then connect 
to a PC or PLC via Ethernet (Section 4.4.3, page 34) or one of 
the optional field buses (EtherCAT, PROFIBUS-DP or 
CANopen). The configuration is carried out exclusively via the 
Ethernet interface.

For setting an IP address or for logging purposes you can also 
use the RS-232 interface of the Q.gate or Q.pac Test Con-
troller (Section 4.4.4, page 35).

• Connect single modules directly to the PC or a PLC; refer to 
Section 4.4.5 from page 36 onwards.

For the serial interface cables use two-wire, twisted cables, with 
a screen if possible. Section 6.1, Using serial interfaces, 
page 135 provides comprehensive instructions for setting up 
serial interface links.

For Ethernet and EtherCAT we recommend the use of cables to 
Cat-5e or better.

The module baud rate set as shipped is 24 MBaud (factory set-
ting). Depending on the length of the interface cable, you may 
have to reduce the speed of data transmission; refer to the follow-
ing table. The overall length of the interface cable consists of the 
length of all cables between the individual modules and the cable 
length to the Test Controller or PC.

4.4.1 Connecting modules to Q.gate

The Q.gate Test Controller can be inserted into a base just like a 
normal Q.bloxx module. However, only use the far left or far right 
base, because the module has integral terminating resistances 
and therefore terminates this end of the interface line. Any set 
base address is ignored by the Test Controller.

Cable length in meters Maximum baud rate

1000 < 500 kBaud

100 < 1500 kBaud

20 < 6000 kBaud

10 >6 to 48 MBaud
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IMPORTANT
Make sure that the terminating resistances at the (other) ends of 
the interface cables are activated. No resistances should be acti-
vated in the base of the Q.gate. They are permanently fitted in 
the Q.gate Test Controller and are always active.

Since the Q.bloxx modules plugged into the socket are only con-
nected to the interface UART 1 on the socket, they appear in the 
Q.gate Test Controller only for UART 1. In order to be able to use 
UART 2 of the Test Controller you have to insert the Q.bloxx 
Extension Socket QES; refer to Section 4.1.5, page 26.

The interfaces of the Test Controllers to the PC or PLC are acces-
sible at the front: Ethernet, USB and RS-232. You can in each 
case only use one of the Ethernet or USB interfaces at any one 
time. Currently however, the USB interface cannot be used. The 
RS-232 interface is used as a monitoring interface and is not suit-
able for the module configuration.

4.4.2 Connecting modules to Q.pac

The Q.pac Test Controller is inserted directly onto a mounting 
rail (35 mm DIN rail according to DIN EN 60715) and connected 
to the bases via cables and plugs. If you want to exploit the maxi-
mum number of 64 modules, you must connect each of all four 
serial interfaces (UARTs) of the Q.pac to 16 Q.bloxx modules. The 
sync lines are not needed and the synchronization takes place 
through the UART lines. In doing this pay attention to the maxi-
mum line length of the individual interface cables; refer to the 
table on page 31.

Fig. 4-8 Terminal arrangement on the Q.pac Test Controller (top).

EtherCAT EtherCAT Ethernet
IN OUT TCP/IP Device

RS-232USB
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Fig. 4-9 Terminal arrangement on the Q.pac Test Controller (bot-
tom).
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Pin assignment for plug-in terminal X1

0 V 0 V, GND

+V Supply voltage +10 to 30 VDC

B Interface RS-485 B

A Interface RS-485 A

Pin assignment for plug-in terminal X2

A1 UART 1 A
Max. 16 modules

B1 UART 1 B

A2 UART 2 A
Max. 16 modules

B2 UART 2 B

A3 UART 3 A
Max. 16 modules

B3 UART 3 B

A4 UART 4 A
Max. 16 modules

B4 UART 4 B

SyA Sync A Input/output for synchronization, e.g. 
with another Test ControllerSyB Sync B

Pin assignment for plug-in terminal X3

0 V 0 V, GND

DI1 Digital Input 1

DI2 Digital Input 2

DI3 Digital Input 3

DI4 Digital Input 4

DO1 Digital Output 1
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Fig. 4-10 Pin assignment for the plug-in terminals of the Q.pac Test 
Controller.

➡ If you want to use all four interfaces, then in each case with all 
four groups you must use the connection for UART 1 on the 
socket or insert the Q.bloxx Extension Socket QES to be able to 
use the interface lines for UART 2 available on the sockets. Refer 
to Section 4.1.5, Q.bloxx Extension Socket QES, page 26.

4.4.3 Connecting Q.gate/Q.pac via Ethernet to a PC/PLC

Both Q.gate and also Q.pac use DHCP (Dynamic Host Configura-
tion Protocol) to obtain an address from a server in the network. 
In this case you only have to connect the module or the Test Con-
troller to an Ethernet switch. An IP address is assigned automati-
cally.

Tip
We recommend the use of industrial Ethernet switches. Both 
Q.gate and Q.pac use autonegotiation and operate, if available, 
with 100 Mbit/s and full duplex for the transmission.

Connection without a server If you are not connected to a network or there is no server in the 
network, you should set your PC to a fixed address in the range 
192.168.1.x (Control Panel > Network) and connect to the Test 
Controller . If the Test Controller does not receive an IP address 
from a server, then it adjusts to its static IP address after a few 
seconds. The factory setting of the static IP address of the Test 
Controller is 192.168.1.28. Then set a suitable new address on 
the Test Controller and set your PC back to the original address, 
because otherwise you will not be able to establish any connec-
tion to the module.

Tip
Refer also to Section 6.2, Ethernet on the PC, on page 138 for the 
display and setting of the PC IP address.

Connection in a network 

with a server

In the factory setting the Test Controllers use DHCP, i.e. they 
receive a valid network address from a server which is present in 

DO2 Digital Output 2

DO3 Digital Output 3

DO4 Digital Output 4

+V +10 to 30 VDC for digital inputs/outputs

Pin assignment for plug-in terminal X3
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the network. Connect the PC or the PLC to the same network. 
Then you can establish the link immediately via test.commander 
and can therefore also assign a fixed address to the Test Con-
troller if required. Refer also to Section 6.2 on page 138.

Procedure Setting an Ethernet address (IP address)

1. Make sure that the current version of the test.commander 
software is installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.1 on page 102.

2. Start the software.

3. Using the menu Utilities > Controller network terminal  
call the dialog for finding Test Controllers.

4. Click on Configure IP settings.

5. Select Manually configure network settings and specify 
the required IP address (IP address), the subnet mask (Sub-
net mask) and – if necessary – the gateway address (Default 
gateway). If in doubt, details can be obtained from your net-
work administrator.

6. Click on Apply to accept the changes.

Example

Selected new IP address for the Test Controller: 192.168.169.85
Possible PC IP address: 192.168.169.10
Subnet masks of the PC and module: 255.255.255.0

Tip
Alternatively, you can also use the wizard for the initial operation 
in the test.commander program.

Section 6.2, Ethernet on the PC on page 138 contains further 
information about the use of Ethernet addresses and subnet 
masks.

4.4.4 Using the RS-232 interface of Q.gate or Q.pac

The RS-232 interface is used largely for the output of protocol 
information and for setting the IP address if this is not possible 
elsewhere. If required, a GPS device can also be connected to this 
interface; in this respect refer to Section 4.5.2, page 41.

The RS-232 interface of the Q.gate Test Controller is located 
below the USB interface at the front. For the link to a PC you 
require the supplied cable with the 3.5 mm stereo jack plug.
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Fig. 4-11 Pin assignment for RS-232 on the jack plug.

The RS-232 interface of the Q.pac Test Controller is located on 
the underside (9-pole SUB-D socket with standard pin assign-
ment).

Procedure Setting an Ethernet address (IP address) via RS-232

1. Make sure that the current version of the test.commander 
software is installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.1 on page 102.

2. Start the software.

3. Using the menu Utilities > Controller serial terminal call 
the dialog for finding Test Controllers.

4. Specify the required IP address (IP address), the subnet 
mask (Subnet mask) and – if necessary – the gateway 
address (Default gateway). If in doubt, details can be 
obtained from your network administrator.

5. Click on Apply to accept the changes.

Example

Selected new IP address for the Test Controller: 192.168.169.85
Possible PC IP address: 192.168.169.10
Subnet masks of the PC and module: 255.255.255.0

Section 6.2, Ethernet on the PC on page 138 contains further 
information about the use of Ethernet addresses and subnet 
masks.

4.4.5 Connecting modules directly to a PC/PLC

You can connect modules directly to an RS-485 interface via the 
base connections UART 1A and UART 1B. The following protocols 
are available:

• The Gantner fast binary protocol for the programs ICP 100 
and test.commander.

• Modbus RTU for reading and writing variables via registers.

TxGND, 
Ground

Rx
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• ASCII for reading and writing variables (values) with simple 
commands.

The modules switch automatically to the appropriate protocol. 

IMPORTANT
The modules cannot be directly connected to an RS-232 inter-
face. Use an adapter if necessary for converting an RS-232 inter-
face to RS-422 or RS-485, e.g. the interface converter ISK 101 
from Gantner. Refer also to Section 6.1 on page 135.

Fig. 4-12 Assignment for the base socket contacts (plan view).

If you have connected more than 16 modules via the Q.bloxx 
Extension Socket QES, the second interface (UART 2A and 
UART 2B) is also occupied. For this however another RS-485 
interface is required which you then connect to the appropriate 
contacts.

IMPORTANT
Make sure that the terminating resistances are activated at the 
ends of the interface cables (refer also to Section 4.1.3 on 
page 24). With interfaces in the PC an active termination is often 
present, i.e. the interface automatically switches in the resis-
tances as required. Check your interface documentation to find 
out whether this is the case.

4.4.5.1 Establishing connection with the test.commander setup wizard

1. Make sure that the current version of the test.commander 
software is installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.1 on page 102.

Pin assignment

Sync A

UART 2B

UART 2A

Sync B

Supply +10 to 30 VDC

Supply 0 V

UART 1B

UART 1A
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2. Start the software and select the Utilities > Module setup 
assistant 

Another program window opens.

3. Select Options > Communication settings.

4. Under Interface type select the RS-232 direct connection 
and under ComPort the PC connection you are using.

5. Close the dialog with OK.

Further interface parameters are not needed.

6. Click on Find modules.

The program searches the specified interface for connected 
modules and displays all the modules found in the program 
window. If there are addressing conflicts, they are also dis-
played. Specify unique addresses for the modules; refer to 
Section 5.2 on page 103.

4.4.5.2 Establishing connection with ICP 100

1. Make sure that the current version of the ICP 100 software is 
installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.1 on page 102.

2. Start the software and select Communication > Parame-
ters. 

3. Under Interface type select the RS-232 direct connection 
and under ComPort the PC connection you are using.

4. Close the dialog with OK.

The program searches the specified interface for connected 
modules and displays all the modules found in the program 
window. If there are addressing conflicts, they are also dis-
played. Specify unique addresses for the modules; refer to 
Section 5.2 on page 103.

4.5 Synchronization of several systems

The synchronization of several interconnected Q.bloxx modules is 
ensured by the Test Controller. Both Q.gate and Q.pac ensure 
that all slave modules operate synchronously with the maximum 
jitter being approx. ±2 μs over all modules.

You have various methods of obtaining synchronization, even 
with several systems (refer also to Fig. 4-13 on page 40):
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1. Use the time signal in the Q.pac Test Controllers based on the 
IRIG standard (Inter Range Instrumentation Group) to syn-
chronize all other Test Controllers to one master controller.

The master controller (first device in the chain of devices) 
uses its internal clock for the date/time stamp (gray path in 
Fig. 4-13). For this type of synchronization you must lay syn-
chronization lines between the Test Controllers; the maxi-
mum length of all lines together is 400 m. The master control-
ler transfers the time stamp through an RS-485 link to the 
other Test Controllers. This method achieves the best time 
synchronization with the smallest jitter (approx. ±2 μs) 
between the individual modules, because the time informa-
tion passes simultaneously to all Test Controllers.

2. You connect a radio receiver for time signals, e.g. for DCF77 
which converts the received time signal to IRIG-B, to a Q.pac 
Test Controller.

As master controller this then synchronizes all other Test 
Controllers using IRIG (orange colored path in Fig. 4-13) as 
with Variant 1. If it is not possible to connect the individual 
Test Controllers via synchronization lines or this is not 
desired, you can also connect a receiver to each Test Con-
troller (Variant 2b).

3. You connect an NMEA-0183 compatible GPS receiver (Global 
Positioning System) to a Q.pac Test Controller, which then, 
similar to Variant 1, synchronizes as master controller all 
other Test Controllers.

With this method the time information of the GPS signal is 
evaluated instead of a pure time signal. In addition you can 
also process the position details of the GPS receiver in the 
system and assign the measurements (light blue path in 
Fig. 4-13). If it is not possible to connect the individual Test 
Controllers via synchronization lines or this is not desired, 
you can also connect a receiver to each Test Controller (also 
to Q.gate) (Variant 3b).

4. You define a PC as an SNTP time server which can distribute 
the NTP time stamp to all Q.gate or Q.pac Test Controllers 
(dark blue path in Fig. 4-13).
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Fig. 4-13 Possible types of time synchronization.

The absolute accuracy of the time information depends on the 
method used. If you do not want to use or cannot use any time 
synchronization lines, e.g. because the spacing of the systems is 
too large, you must expect greater deviations. In Variant 2b the 
deviations are about 5 milliseconds depending on the receiver, 
but this depends on various factors, e.g. also on how often the 
time information is received. In the variant 3b the time accuracy 
of the GPS signal is decisive, which is only approx. 1 second abso-
lute.

The fourth method uses, for example, the SNTP protocol (Simple 
Network Time Protocol) used in the Microsoft Windows operating 
system to transfer the date and time via Ethernet. However, the 
individual Test Controllers must always query the time server in 
order to be able to synchronize their times to the time server. The 
achievable accuracy is therefore not as good as for the three 
other methods. If required, you can also set up a (full) NTP time 
server on a PC and synchronize it with a time server in the Inter-
net. You will find further information about this at http://
www.meinberg.de (here you can also downloaded a time server 
program) and at http://www.pool.ntp.org. The time accuracy then 

http://www.meinberg.de
http://www.meinberg.de
http://www.pool.ntp.org
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only depends on the response times in your network, but here too 
it might amount to several milliseconds.

Configuration of the relevant method takes place using the 
test.commander program, see Section 5.8.3.3, Synchronization, 
page 123. If you combine several synchronization methods, the 
best possible one is always used from those available:

1. Hardware synchronization (synchronization of the Q.series, 
EtherCAT, IRIG-B or AFNOR using a time signal, e.g. DCF77)

2. Time signal from GPS (NMEA-0183)

3. SNTP

4.5.1 Connection of a radio receiver for time signals

Depending on the output signal of your receiver you basically 
have two methods:

1. The receiver, e.g. for DCF77, is connected to the digital IOs of 
the Q.pac Test Controller (plug-in terminal 1, connections 1 
and 2; refer to Section 4.4.2, page 32). The variant is suitable 
if the receiver outputs signals at a TTL level.

2. The receiver is connected through the sync input (plug-in ter-
minal 2, connections 9 and 10; refer to Section 4.4.2, 
page 32). The variant is only possible when the receiver has 
an RS-485 interface, because the sync input uses this inter-
face.

The configuration is carried out using the program test.com-
mander and the menu Settings > Synchronization > Sync. 
settings. Protocol; refer to Section 5.8.3.3, page 123.

4.5.2 Connection of a GPS receiver

NMEA-compatible GPS receivers normally have a serial interface 
and are therefore connected through RS-232 to the Test Con-
troller. With Q.gate the RS-232 input at the front is used and with 
Q.pac the RS-232 input on the top side (next to the Ethernet con-
nection).

The configuration is carried out using the program test.com-
mander and the menu Settings > Synchronization > Sync. 
settings. Protocol; refer also to Section 5.8.3.3, page 123.

Tip
Use the variable GetPositioningData to evaluate the individual 
data items of your GPS receiver.
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4.6 Module flashing frequency

The modules have three LEDs: one blue LED on the upper edge 
and one red LED per connector strip. In normal operation the 
blue LED lights, but the red LEDs do not light. Depending on the 
error, the LED of the affected connector strip or the blue LED 
lights or all LEDs flash in a certain order. In the following illustra-
tions a short dash corresponds to short flash and a long dash to a 
long flash.

4.6.1 SOS, configuration error

Fig. 4-14 Flashing sequence with an incorrect module or when 
there are no settings in the base.

Cause: The configuration saved in the base does not match that in 
the module.

There may be two reasons for this:

1. There is no configuration in the base yet.

2. The module type saved in the base configuration differs from 
the plugged-in module, therefore the configuration cannot be 
accepted.

Consequently, either change the module for the correct module 
type or reconfigure the module (Chapter 5, Configuration, 
page 101). The (new) configuration is then automatically saved in 
the base.

4.6.2 Firmware download

Fig. 4-15 Flashing sequence on downloading the module firmware.

The LEDs flash while the firmware download into the module is 
taking place.

4.6.3 Activating the firmware download

Fig. 4-16 Flashing sequence on activating the firmware.

blue LED
red LED 1
red LED 2

blue LED
red LED 1
red LED 2

blue LED
red LED 1
red LED 2
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The LEDs flash while the firmware is being configured after a 
download. After the download the module must be restarted.

4.6.4 Problems during data transmission

Fig. 4-17 Flashing sequence for problems during the data transmis-
sion.

These flashing sequences indicate a problem with the communi-
cation. Check the following:

1. Is the interface link between the modules in order (are the 
bases plugged together or connected to the cables correctly)?

2. Is the interface link between the modules and the Test Con-
troller in order?

3. Is wiring of the interface connections correct?

Then restart the system (by switching off, waiting one minute and 
then switching on again). If these measures do not remedy the 
error, then contact your customer consultant or Gantner 
Instruments GmbH directly.

4.6.5 LED displays in normal operation

For modules with analog inputs a red illuminated LED indicates 
that the measurement range has been exceeded on at least one 
input. You can suppress this indication in the module configura-
tion.

For modules with digital inputs or outputs an orange illuminated 
LED indicates that an input or output is active.

or
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4.7 The modules and their connection options

1) Half bridge only with Q.bloxx Terminal
2) Quarter bridge with Q.bloxx Terminal

Modules: A 
101

A 
102

A 
103

A 
104

A 
105

A 
106

A 
107

A 
108

A 
109

A 
111

A 
116

Signal inputs

Voltage X X X X X X X

Current X X X X X

Potentiometer X X

Resistance X X X

Pt100, Pt1000 X X X

Thermocouple X X X

(Strain gauges) full + half 
bridge

X X X X1) X

Strain-gauge quarter bridge X2) X2) X2) X2) X

Inductive full and half bridge X

LVDT, RVDT X

IEPE/ICP® Sensor X X X

Digital input: frequency, 
pulse width, counter

X

Digital input: Status X X X X X X

Signal outputs

Voltage X X X

Current X X

Digital output: 
frequency, pulse width

X

Digital output: Status X X X X X X

Number of channels 2 1 8 8 4 2 4 8 4 4 8

Data rate (in Hz) 100 k 100 k 100 100 10 10 k 10 k 10 k 100 k 100 k 10 k

For description refer to page 46 51 55 57 59 61 65 69 71 73 75
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Modules: A 123 A 124 A 127 A 128 D 101 D 104 D 105 D 107

Signal inputs

Voltage X X X X

Current

Potentiometer

Resistance

Pt100, Pt1000

Thermocouple X

(Strain gauges) full + half 
bridge

Strain-gauge quarter bridge 

Inductive full and half bridge

LVDT, RVDT

IEPE/ICP® Sensor

Digital input: frequency, pulse 
width, counter

X X

Digital input: Status X X X

Signal outputs

Voltage

Current

Digital output: 
frequency, pulse width

X

Digital output: Status X X

Number of channels 4 4 4 4 8 16 16 6

Data rate (in Hz) 100 k 10 k 100 k 100 k
up to 
100 k

10 k 10 k 1 M

For description refer to page 83 85 87 89 91 94 96 97
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4.8 Q.bloxx A101: Connecting sensors and I/O

The Q.bloxx Module A101 has two electrically isolated analog 
inputs and two digital inputs or outputs. The pin assignment of 
the two connector strips is identical and the connection terminals 
have numbers for identifying the connections.

GND identifies the measurement ground of an input, 0 V and +V 
refer to the (external) supply voltage connections. Measurement 
ground and (module) supply voltage are electrically isolated in 
the module.

Fig. 4-18 Pin assignment for Q.bloxx Module A101.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.8.1 Voltage

With voltage measurements two connection variants are possible, 
depending on the level of the voltages to be measured: up to 10 V 
and up to 60 V.

4
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1
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1
1
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1
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7 (GND)

U
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7 (GND)

I

3 (+)

7 (GND)

2
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2

3
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120Ω 350Ω

6

4
1

6

4
1

IEPE
7 (GND)
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Din Dout
10

+V

0V

10

2

5
3

4

1 60 V
2 UF
3 AIn 1
4 AIn 2
5 AIn 3
6 AIn 4
7 GND
8 IEPE
9 TEDS
10 DIO

1 60 V
2 UF
3 AIn 1
4 AIn 2
5 AIn 3
6 AIn 4
7 GND
8 IEPE
9 TEDS
10 DIO

requires Q.bloxx 
Terminal CJC
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-19 A101, measurement of voltage.

4.8.2 Current

A shunt resistance of 50  is integrated into the Q.bloxx Module 
A101 for current measurement. This facilitates the measurement 
of currents of up to 25 mA. For higher currents use a voltage mea-
surement and an external shunt; refer to Section 6.5, page 147.

Fig. 4-20 A101, measurement of current.

4.8.3 Potentiometer

Potentiometers with resistances between 1 k and 10 k are con-
nected in a three-wire configuration.

Fig. 4-21 A101, measurement with potentiometers.

4.8.4 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire 
or four-wire circuits. You specify the selected type of circuit 
during the module configuration (Type column).

Voltages up to 10 V Voltages up to 60 V

U
3 (+)

7 (GND)
U

1 (+)

7 (GND)

I

3 (+)

7 (GND)

2

3

4
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Fig. 4-22 A101, measurement of resistance and Pt100/1000 probes.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.3, Connecting 
sensors with sensing leads, page 143.

4.8.5 Thermocouple

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold point 
compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A101 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.6, Measuring with thermocouples, page 148.

Fig. 4-23 A101, measurement with thermocouple using Q.bloxx 
Terminal CJC-A101.

4.8.6 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 

2-wire circuit 4-wire circuit

2

3

2

5
3

4

4 (–)

3 (+)

Q
.b
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bridges the side drawn in dashes and the connection 5 are omit-
ted.

The bridge excitation voltage is 2.5 V. 

Fig. 4-24 A101, measurement with full and half bridges.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.3, Connecting 
sensors with sensing leads, page 143.

4.8.7 Strain-gauge quarter bridges

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A101 with120  or B4/350-A101 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage is 2.5 V.

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the Q.bloxx Terminal, you have to select a 
full bridge circuit as the bridge type for the channel.

Fig. 4-25 A101, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4.

4.8.8 IEPE/ICP® sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

4

(5)

2 (+)
3

7 (GND)
6

120Ω 350Ω

6

4
1

6

4
1
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Fig. 4-26 A101, measurement with IEPE or ICP® sensors.

4.8.9 Digital input and output

On each connecting plug a contact is available for an input or out-
put. You can use the appropriate function depending on the wir-
ing.

Fig. 4-27 A101, digital input and output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.

IEPE
7 (GND)

8 (+)

Input Output

Din Dout
10

+V

0V

10
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4.9 Q.bloxx A102: Connecting sensors and I/O

The Q.bloxx Module A102 has one electrically isolated analog 
input, one analog output and two digital inputs or outputs electri-
cally isolated from the analog section. The assignment of both 
connector strips is not identical. The plug number is specified in 
the following. The connection terminals have numbers for identi-
fying the connections.

GND identifies the measurement ground of an input, 0 V and +V 
refer to the (external) supply voltage connections. Measurement 
ground and (module) supply voltage are electrically isolated in 
the module.

Fig. 4-28 Pin assignment for Q.bloxx Module A102.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.9.1 Voltage

You can measure voltages of up to 10 V via Plug 2.

Plug 1, outputs

Plug 1, inputs

Plug 2, inputs
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-29 A102, measurement of voltage, Plug 2.

4.9.2 Current

A shunt resistance of 50  is integrated into the Q.bloxx Module 
A102 for current measurement. This facilitates the measurement 
of currents of up to 25 mA via Plug 2. For higher currents use a 
voltage measurement and an external shunt; refer to Section 6.5, 
page 147.

Fig. 4-30 A102, measurement of current, Plug 2.

4.9.3 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 
bridges the side drawn in dashes and the connection 4 are omit-
ted.

The bridge excitation voltage is switched via software between 
1 V, 2.5 V, 5 V and 10 V. 

Fig. 4-31 A102, measurement with full and half bridges, Plug 2.

U
8 (+)
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9 (+)
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Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.3, Connecting 
sensors with sensing leads, page 143.

4.9.4 Strain-gauge quarter bridges

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A102 with120  or B4/350-A102 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage is switched via software between 
1 V, 2.5 V, 5 V and 10 V. 

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the , you have to select a full bridge circuit 
as the bridge type for the channel.

Fig. 4-32 A102, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4 on Plug 2.

4.9.5 IEPE/ICP® sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

Fig. 4-33 A102, measurement with IEPE and ICP® sensors, Plug 2.

4.9.6 Analog output

An analog output for voltage or current is available on Plug 1. The 
selection between voltage and current is made via software.

120Ω 350Ω
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Fig. 4-34 A102, output of voltage or current, Plug 1.

4.9.7 Digital input and output

Contacts for four inputs and two outputs are available on Plug 1.

Fig. 4-35 A102, digital input and output, Plug 1.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.

U
1 (+)

2 (–)
I
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Input Output
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4.10 Q.bloxx A103: Connecting sensors and I/O

The Q.bloxx Module A103 has eight electrically isolated analog 
inputs and two digital inputs and outputs. The pin assignment of 
the two connector strips is identical and the connection terminals 
have numbers for identifying the connections. You will find the 
associated figures in each case at the same place in the circuit 
diagrams, for example each of the figures quoted in the second 
place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections. Measurement ground (–) and the (module) sup-
ply voltage are electrically isolated in the module.

Fig. 4-36 Pin assignment for Q.bloxx Module A103.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.10.1 Voltage

You can measure voltages of up to ±10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-37 A103, measurement of voltage.

4.10.2 Current

For current measurement you need the connecting plug Q.bloxx 
Terminal SR containing the shunt resistances. This facilitates the 
measurement of currents of up to 25 mA.

Fig. 4-38 A103, measurement of current via Q.bloxx Terminal SR.

4.10.3 Digital input and output

On each connecting plug two contacts are available for an input 
and an output.

Fig. 4-39 A103, Digital Input and Output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.
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4.11 Q.bloxx A104: Connecting sensors

The Q.bloxx Module A104 has eight electrically isolated analog 
inputs for thermocouples or voltages. The pin assignment of the 
two connector strips is identical and the connection terminals 
have numbers for identifying the connections. You will find the 
associated figures in each case at the same place in the circuit 
diagrams, for example each of the figures quoted in the second 
place belong to one possible connection method.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 4-40 Pin assignment for Q.bloxx Module A104.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.11.1 Voltage

You can measure voltages of up to 80 mV.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-41 A104, voltage measurement.

4.11.2 Thermocouple

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold junc-
tion compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A104 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.6, Measuring with thermocouples, page 148.

Fig. 4-42 A104, measurement with thermocouple using Q.bloxx 
Terminal CJC-A104.
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4.12 Q.bloxx A105: Connecting sensors

The Q.bloxx Module A 105 has four electrically isolated analog 
inputs. The pin assignment of the two connector strips is identical 
and the connection terminals have numbers for identifying the 
connections. You will find the associated figures in each case at 
the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

GND identifies the measurement ground of an input; measure-
ment ground and the (module) supply voltage are electrically iso-
lated in the module.

Fig. 4-43 Pin assignment for Q.bloxx Module A105.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

4.12.1 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire, 
three-wire or four-wire circuits. However, you must in each case 
connect all the terminals, i.e. you specify the circuit used for the 
type of circuit when configuring the module (Type column), but 
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with two and three-wire circuits the unused terminals must be 
bridged.

Fig. 4-44 A105, measurement of resistance and Pt100/1000 probes.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.3, Connecting 
sensors with sensing leads, page 143.

4-wire circuit
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4.13 Q.bloxx A106: Connecting sensors and I/O

The Q.bloxx Module A106 has two electrically isolated analog 
inputs, two analog outputs and four digital inputs and outputs. 
The pin assignment of the two connector strips is identical and 
the connection terminals have numbers for identifying the con-
nections.

GND identifies the analog and the measurement ground, 0 V and 
+V refer to the (external) supply voltage connections. Measure-
ment ground/GND and (module) supply voltage are electrically 
isolated in the module. The measurement ground for input and 
the analog ground (output) are identical.

Fig. 4-45 Pin assignment for Q.bloxx Module A106.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.13.1 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 
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bridges the side drawn in broken lines and the connection 10 are 
omitted.

The bridge excitation voltage can be 2.5 V or 5 V (DC or CF).

Fig. 4-46 A106, measurement with full and half bridges.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.3, Connecting 
sensors with sensing leads, page 143.

4.13.2 Strain-gauge quarter bridge

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A106 with120  or B4/350-A106 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage can be 2.5 V or 5 V (DC or CF).

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Select a half-bridge circuit as the type of bridge for the channel.

Fig. 4-47 A106, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4.

4.13.3 Inductive full and half bridges

With inductive full bridges all connections are occupied. If the 
sensor has no sensing leads, you specify this during the module 
configuration (Type column). With half bridges the side drawn in 
broken lines and the connection 10 are omitted.

The bridge excitation voltage can be 2.5 V or 5 V.
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IMPORTANT
During the configuration set CF 4800 Hz (carrier frequency) in 
the Type column; inductive sensors cannot be operated with 
direct voltage (DC) or 600 Hz carrier frequency.

Fig. 4-48 A106, measurement with inductive full and half bridges.

4.13.4 LVDT, RVDT

With (inductive) LVDTs or RVDTs all connections can be occu-
pied, but you can also connect without sense leads and state this 
in the Type column when configuring the module.

The bridge excitation voltage can be 2.5 V or 5 V.

IMPORTANT
During the configuration set CF 4800 Hz (carrier frequency) in 
the Type column; inductive sensors cannot be operated with 
direct voltage (DC) or 600 Hz carrier frequency.

Fig. 4-49 A106, measurement with LVDTs and RVDTs.

4.13.5 Analog output

An analog voltage output is available on each connecting plug.

Fig. 4-50 A106, analog output.
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4.13.6 Digital input and output

On each connecting plug two contacts are available for an input 
or output. You can use the appropriate function depending on the 
wiring.

Fig. 4-51 A106, Digital Input and Output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.

Input Output

Din Dout
1, 2

+V

0V
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4.14 Q.bloxx A107: Connecting sensors

The Q.bloxx Module A 107 has four electrically isolated analog 
inputs. The pin assignment of the two connector strips is identical 
and the connection terminals have numbers for identifying the 
connections. You will find the associated figures in each case at 
the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

GND identifies the measurement ground. The four inputs (UF to 
GND) are electrically isolated in the module one to the other and 
to the (module) supply voltage.

Fig. 4-52 Pin assignment for Q.bloxx Module A107.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.14.1 Voltage

You can measure voltages of up to 10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-53 A107, measurement of voltage.

4.14.2 Current

A shunt resistance of 50  is integrated into the Q.bloxx Module 
A107 for current measurement. This facilitates the measurement 
of currents of up to 25 mA. For higher currents use a voltage mea-
surement and an external shunt; refer to Section 6.5, page 147.

Fig. 4-54 A107, measurement of current.

4.14.3 Potentiometer

Potentiometers with resistances between 1 k and 10 k are con-
nected in a three-wire configuration.

Fig. 4-55 A107, measurement with potentiometers.

4.14.4 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire 
or four-wire circuits. You specify the selected type of circuit 
during the module configuration (Type column).

Fig. 4-56 A107, measurement of resistance and Pt100/1000 probes.

U
2, 7 (+)

5, 10 (GND)

I

2, 7 (+)

5, 10 (GND)

1, 6

5, 10 (GND)

2, 7

2-wire circuit 4-wire circuit

1, 6

2, 7

1, 6

4, 9
2, 7

3, 8



Q.series
Gantner Instruments GmbH 67

4     Connecting the modules → Q.bloxx A107: Connecting sensors

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.3, Connecting 
sensors with sensing leads, page 143.

4.14.5 Thermocouple

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold point 
compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A107 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.6, Measuring with thermocouples, page 148.

Fig. 4-57 A107, measurement with thermocouple using Q.bloxx 
Terminal CJC-A107.

4.14.6 Full-bridge transducer

With (resistive) full bridges (strain-gauge full bridges) four con-
nections are occupied. If the sensor has sense leads, you should 
connect them to the relevant supply lines (1 and 5 or 6 and 10).

The bridge excitation voltage is 2.5 V. 
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Fig. 4-58 A107, measurement with full bridges.

4.14.7 Strain-gauge half and quarter bridges

For the connection of strain-gauge half or quarter bridges you 
need a special connecting plug which contains the completion 
resistances. The plug can be obtained under the designation 
Q.bloxx Terminal B4/120-A107 with120  or B4/350-A107 with 
350  from Gantner Instruments GmbH.

The bridge excitation voltage is 2.5 V.

IMPORTANT
For strain-gauge quarter bridges the plug must have the same 
resistance values as the strain gauges used, because otherwise 
no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the Q.bloxx Terminal, you have to select a 
full bridge circuit as the bridge type for the channel.

Fig. 4-59 A107, measurement with strain-gauge half bridge and 
quarter bridge using Q.bloxx Terminal B4.
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4.15 Q.bloxx A108: Connecting sensors and I/O

The Q.bloxx Module A108 has eight electrically isolated analog 
inputs and two digital inputs and outputs. The pin assignment of 
the two connector strips is identical and the connection terminals 
have numbers for identifying the connections. You will find the 
associated figures in each case at the same place in the circuit 
diagrams, for example each of the figures quoted in the second 
place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections. Measurement ground (–) and the (module) sup-
ply voltage are electrically isolated in the module.

Fig. 4-60 Pin assignment for Q.bloxx Module A108.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.15.1 Voltage

You can measure voltages of up to 10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-61 A108, voltage measurement.

4.15.2 Current

For current measurement you need the Q.bloxx Terminal SR con-
necting plug containing the shunt resistances. This facilitates the 
measurement of currents of up to 25 mA.

Fig. 4-62 A108, current measurement using the Q.bloxx Terminal 
SR.

4.15.3 Digital input and output

On each connecting plug of the terminal version two contacts are 
available in each case for one input and one output.

Fig. 4-63 A108, digital input and output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.

U
3, 5, 7, 9 (AIn +)

4, 6, 8, 10 (AIn –)

I

3, 5, 7, 9 (AIn +)

4, 6, 8, 10 (AIn–)

Input Output

Din Dout

1

+V

0V

2



Q.series
Gantner Instruments GmbH 71

4     Connecting the modules → Q.bloxx A109: Connecting I/O and outputs

4.16 Q.bloxx A109: Connecting I/O and outputs

The Q.bloxx Module A109 has four electrically isolated analog 
outputs, four digital inputs and four digital outputs. The assign-
ment of both connector strips is not identical. The plug number is 
specified in the following. The connection terminals have num-
bers for identifying the connections. You will find the associated 
figures in each case at the same place in the circuit diagrams, for 
example each of the figures quoted in the second place belong to 
one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections, NC indicates “not assigned”. Analog ground (–) 
and the (external) supply voltage (0 V) are electrically isolated in 
the module.

Fig. 4-64 Pin assignment for Q.bloxx Module A109.

 4.16.1 Digital input and output, Plug 1

On Plug 1 contacts for four inputs and four outputs are available. 
Since the inputs and outputs of this module are electrically iso-
lated from the supply voltage, you must also connect 0 V for the 
inputs and 0 V and a supply voltage (+V) for the outputs.
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Fig. 4-65 A109, digital input and output, Plug 1.

The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.

Possible combinations of contact assignments for the inputs are 
shown in the following table; refer also to the block diagrams for 
Module D101.

1) e.g. counter with additional input for counting direction 
or 2-phase counter signals or frequency measurement 
with direction detection (torque transducers)

2) e.g. counter with additional inputs for counting direction, 
zero reference and reset/enable for zero reference

4.16.2 Analog output, Plug 2

The analog outputs on Plug 2 supply voltage or current. Selection 
is made via software.

Fig. 4-66 A109, output of voltage or current, Plug 2.

6 7 8 9

status status status status
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4.17 Q.bloxx A111: Connecting sensors and I/O

The Q.bloxx Module A 111 has four electrically isolated analog 
inputs. The pin assignment of the two connector strips is identical 
and the connection terminals have numbers for identifying the 
connections. You will find the associated figures in each case at 
the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method. NC signifies “No Connection”.

Measurement ground and (module) supply voltage are electri-
cally isolated in the module.

Fig. 4-67 Pin assignment for Q.bloxx Module A111.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.17.1 Voltage

You can measure voltages of up to 10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-68 A111, measurement of voltage.

4.17.2 IEPE/ICP® Sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

Fig. 4-69 A111, measurement with IEPE or ICP® sensors.
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4.18 Q.bloxx A116: Connecting sensors

The Q.bloxx Module A116 has eight analog inputs. We recom-
mend that either the Q.bloxx Connection Terminal A116 (Fig. 4-
71) or the Cable A116 (Fig. 4-72) is used with free ends for con-
nection. You will find the associated connectors in each case at 
the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belongs to one possible con-
nection method.

The channels (measurement ground) are electrically isolated 
against the (module) supply voltage and the interface.

Fig. 4-70 Pin assignment for Q.bloxx Module A116.
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Fig. 4-71 Terminal assignment for the Q.bloxx Connection Terminal 
CT A116.
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Socket connection

1

Pair 1
Light brown UExc+ A3

Light brown/red UExc– A4

Pair 2
Light green USen+ B4

Light green/black USen– A5

Pair 3
White USig+ B3

White/black USig– B5

2

Pair 1
Red/white UExc+ A7

Red/blue UExc– A8

Pair 2
Yellow/red USen+ B8

Yellow/blue USen– A9

Pair 3
Grey/red USig+ B7

Grey/blue USig– B9
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3

Pair 1
Blue UExc+ A11

Blue/white UExc– A12

Pair 2
Pink/red USen+ B12

Pink/blue USen– A13

Pair 3
Light green/yellow USig+ B11

Light green/green USig– B13

4

Pair 1
Green/white UExc+ A15

Light green/white UExc– A16

Pair 2
Light blue/blue USen+ B16

Light blue/red USen– A17

Pair 3
Black USig+ B15

Black/white USig– B17

5

Pair 1
Pink UExc+ A19

Pink/black UExc– A20

Pair 2
Orange/white USen+ B20

Grey/white USen– A21

Pair 3
White/red USig+ B19

White/blue USig– B21

6

Pair 1
Light green/red UExc+ A23

Green/blue UExc– A24

Pair 2
Red USen+ B24

Red/black USen– A25

Pair 3
Purple USig+ B23

Purple/white USig– B25

Input/
cable 

bundle
Pairing Cable color

Sensor connec-
tion

Socket connection
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Fig. 4-72 Assignment of the cores for a cable termination with free 
ends Cable A116.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.18.1 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) six connec-
tions are used per measuring point. If the sensor has no sensing 
leads, you specify this during the module configuration (Type col-
umn); the USen inputs then remain open. With half bridges the 

side drawn in dashes and the USig- connection are omitted.

The bridge excitation voltage is 2 VDC; with 350  sensor resis-

tance you can also use 4 VDC. The internal shunt resistance can 

be activated also with full and half bridges.

7

Pair 1
Green UExc+ A27

Green/black UExc– A28

Pair 2
Light blue/green USen+ B28

Light blue/yellow USen– A29

Pair 3
Light yellow USig+ B27

Light yellow/red USig– B29

8

Pair 1
Grey UExc+ A31

Grey/black UExc– A32

Pair 2
White/yellow USen+ B32

White/green USen– A33

Pair 3
Brown USig+ B31

Brown/white USig– B33

Input/
cable 

bundle
Pairing Cable color

Sensor connec-
tion

Socket connection



Q.series
Gantner Instruments GmbH 79

4     Connecting the modules → Q.bloxx A116: Connecting sensors

Fig. 4-73 A116, measurement with full and half bridges, direct con-
nection; USIG = signal voltage (output signal), USEN = 

sense lead, UEXC = excitation voltage

You will find the terminal assignment for the terminal CT A116 or 
the Cable A116 in the first section of this chapter. For the activa-
tion of the shunt resistance refer to Section 4.18.3.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.3, Connecting 
sensors with sensing leads, page 143.

4.18.2 Strain-gauge quarter bridge

With this module, for the connection of strain-gauge quarter 
bridges you do not need any special connection plugs as the 120  
and 350  completion resistances are present in the module and 
only need to be activated. In addition you can activate the inter-
nal shunt resistance for test purposes.

Internal 
shunt 
100 k

USig+

USig–

UExc+
USen+

UExc–

USen–

Input 1

UExc+ A3

UExc– A4

USen+ B4

USen– A5

USig+ B3

USig– B5

Input 2

UExc+ A7

UExc– A8

USen+ B8

USen– A9

USig+ B8

USig– B9

Input 3

UExc+ A11

UExc– A12

USen+ B12

USen– A13

USig+ B11

USig– B13

Input 4

UExc+ A15

UExc– A16

USen+ B16

USen– A17

USig+ B15

USig– B17

Input 5

UExc+ A19

UExc– A20

USen+ B20

USen– A21

USig+ B19

USig– B21

Input 6

UExc+ A23

UExc– A24

USen+ B24

USen– A25

USig+ B23

USig– B25

Input 7

UExc+ A27

UExc– A28

USen+ B28

USen– A29

USig+ B27

USig– B29

Input 8

UExc+ A31

UExc– A32

USen+ B32

USen– A33

USig+ B31

USig– B33
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The bridge excitation voltage is 2 VDC; with 350  sensor resis-

tance you can also use 4 VDC.

Fig. 4-74 A116, measurement with a strain-gauge quarter bridge, 
direct connection.

Fig. 4-75 A116, measurement with a strain-gauge quarter bridge. 
Connection assignment for the Q.bloxx Connection Termi-
nal CT A116.

You will find the terminal assignment for the Cable A116 in the 
first section of this chapter. With quarter bridges only UEXC+, 

UEXC– and USIG+ are assigned. For the activation of the shunt 

resistance refer to Section 4.18.3.

UExc+

120Ω 350Ω

USig+

UExc–

UExc+

USig+

UExc–

Input 1

UExc+ A3

UExc– A4

USig+ B3

Input 2

UExc+ A7

UExc– A8

USig+ B8

Input 3

UExc+ A11

UExc– A12

USig+ B11

Input 4

UExc+ A15

UExc– A16

USig+ B15

Input 5

UExc+ A19

UExc– A20

USig+ B19

Input 6

UExc+ A23

UExc– A24

USig+ B23

Input 7

UExc+ A27

UExc– A28

USig+ B27

Input 8

UExc+ A31

UExc– A32

USig+ B31

USIG+

UEXC+

Strain gauge2

Q.bloxx 116 Junction Box

2

1 3 5 7

4 6 8

UEXC-

UEXC+

USIG+

Strain gauge1

SG3 SG5 SG7

SG4 SG6 SG8

UEXC-
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With the three-wire circuit the internal completion resistance is 
used in this module to determine the voltage drop over the cable 
and to correct the result accordingly. In this way not only can the 
influence of the temperature on the cable (normal three-wire cir-
cuit) be compensated, but also the loss of sensitivity due to the 
cable resistance over a wide range.

4.18.3 Activating the shunt resistance

You can activate the shunt both via a variable and manually via a 
button.

Open the module settings dialog(Fig. 4-76), activate the tab Vari-
able definition and click in the column Format/balance. The 
dialog of Fig. 4-77 opens.

Fig. 4-76 Module configuration dialog.

Fig. 4-77 Dialog for format settings.
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Fig. 4-78 Dialog for shunt activation.

Manual activation

Define the Direction for the variable on Input/output (Fig. 4-
77) and click on Shunt cal. Activate Control computer in the 
dialog (Fig. 4-78).

Setting a value of 16 for the variable (the channel) activates the 
shunt and 0 deactivates it again.

Activation via variable

Click on Shunt cal. Activate At variable value in the dialog 
(Fig. 4-78) and specify the variable to be used.

Any variable value > 0.5 activates the shunt.
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4.19 Q.bloxx A123: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.bloxx module A123 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs. The pin assignment of the two connector 
strips is identical and the connection terminals have numbers for 
identifying the connections. You will find the associated figures in 
each case at the same place in the circuit diagrams, for example 
each of the figures quoted in the second place belong to one pos-
sible connection method. 

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module. NC signifies “No Connection”. 
The plugs for the A123 module are 5-way plugs with push-in 
spring technology, i.e. you can insert a solid wire or a fine-
stranded wire with a wire-end sleeve directly without screwing 

(max. 1.5 mm2). With a screwdriver press on the white opener to 
remove the connection.

Fig. 4-79 Pin assignment and plugs for the Q.bloxx module A123.

U
2, 7 (+)

4, 9 (–)

1 NC
2 AIn 1+
3 NC
4 AIn 1–
5 NC
6 NC
7 AIn 2+
8 NC
9 AIn 2–
10 NC

1 NC
2 AIn 3+
3 NC
4 AIn 3–
5 NC
6 NC
7 AIn 4+
8 NC
9 AIn 4–
10 NC

1
0

1
1
0

1
P

lu
g

 1
P

lu
g

 2

I Rext.

2, 7 (+)

4, 9 (-)
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Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.19.1 Voltage

You can measure voltage differences of up to ±10 V. The voltage 
level (the potential) may be up to 1200 VDC.

IMPORTANT
Voltage differences which exceed the admissible limits produce 
incorrect measurement data, because the inputs are protected 
against overvoltages and limit the input voltage.

Fig. 4-80 A123, voltage measurement.

4.19.2 Current

You need an (external) shunt resistance for the current measure-
ment, refer also to Section 6.5, page 147.

Fig. 4-81 A123, current measurement using an external shunt 
resistance. 

U
2, 7 (+)

4, 9 (–)

I Rext.

2, 7 (+)

4, 9 (–)
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4.20 Q.bloxx A124: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.bloxx module A124 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs for thermocouples. The terminal assignment 
is identical. You will find the associated figures in each case at 
the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module. The plugs for the A124 module 
are 2-way plugs with push-in spring technology, i.e. you can 
insert a solid wire or a fine-stranded wire with a wire-end sleeve 

directly without screwing (max. 1.5 mm2). The plugs are perma-
nently joined to the housing and cannot be removed. With a 
screwdriver press on the white opener to remove the connection.

Fig. 4-82 Pin assignment for Q.bloxx Module A104.

4, 9 (–)

2, 7 (+)

2 AIn 1+
4 AIn 1–

U
2, 7 (+)

4, 9 (–)

7 AIn 2+
9 AIn 2–

2 AIn 3+
4 AIn 3–

7 AIn 4+
9 AIn 4–
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Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.20.1 Voltage

You can measure voltage differences of up to ±80 mV. The volt-
age level (the potential) may be up to 1200 VDC.

IMPORTANT
Voltage differences which exceed the admissible limits produce 
incorrect measurement data, because the inputs are protected 
against overvoltages and limit the input voltage.

Fig. 4-83 A124, voltage measurement. 

4.20.2 Thermocouple

Thermocouples can be connected directly; the comparative mea-
suring point (cold junction compensation) is integrated in the 
module plug. You can connect the following types of thermocou-
ple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.6, Measuring with thermocouples, page 148.

Fig. 4-84 A124, measurement with a thermocouple. 

U
2, 7 (+)

4, 9 (–)

4, 9 (–)

2, 7 (+)
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4.21 Q.bloxx A127: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.bloxx module A127 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs. The pin assignment of the two connector 
strips is identical and the connection terminals have numbers for 
identifying the connections. You will find the associated figures in 
each case at the same place in the circuit diagrams, for example 
each of the figures quoted in the second place belong to one pos-
sible connection method.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module. NC signifies “No Connection”. 
The plugs for the A127 module are 5-way plugs with push-in 
spring technology, i.e. you can insert a solid wire or a fine-
stranded wire with a wire-end sleeve directly without screwing 

(max. 1.5 mm2). With a screwdriver press on the white opener to 
remove the connection.

Fig. 4-85 Pin assignment and plugs for the Q.bloxx module A127.

1
0

1
1
0

1
P

lu
g

 1
P

lu
g

 2

1 NC
2 AIn 1+
3 NC
4 AIn 1–
5 NC
6 NC
7 AIn 2+
8 NC
9 AIn 2–
10 NC

1 NC
2 AIn 3+
3 NC
4 AIn 3–
5 NC
6 NC
7 AIn 4+
8 NC
9 AIn 4–
10 NC

U
2, 7 (+)

4, 9 (–)

I Rext.

2, 7 (+)

4, 9 (-)
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Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.21.1 Voltage

You can measure voltage differences of up to ±1200 V. Here, var-
ious input voltage ranges from ±40 VDC to ±1200 VDC are possi-

ble. The voltage level (the potential) may be up to 1200 VDC.

Voltages above 1200 V can damage the module.

Each module is tested with a test voltage of 5 kVDC for one min-

ute. A longer duration or a higher voltage can damage the mod-
ule. In addition, each period of overvoltage reduces the service 
life of the module.

Fig. 4-86 A127, measurement of voltage.

IMPORTANT
Voltages which exceed the admissible limits give incorrect mea-
surement data, because the input voltage is internally limited.

4.21.2 Current

Confusing the current and voltage inputs can damage the module 
and/or the external load resistance.

Make sure that no high voltages are applied to the current inputs. 
The voltage drop must not be beyond ±2.4 V.

You need an (external) shunt resistance for the current measure-
ment, refer also to Section 6.5, page 147.

Fig. 4-87 A127, current measurement using an external shunt 
resistance. 

U
2 (+)

4 (–)

I Rext.

7 (+)

9 (–)
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4.22 Q.bloxx A128: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.bloxx module A128 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs. The pin assignment of the two connector 
strips is identical and the connection terminals have numbers for 
identifying the connections. You will find the associated figures in 
each case at the same place in the circuit diagrams, for example 
each of the figures quoted in the second place belong to one pos-
sible connection method.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module. NC signifies “No Connection”. 
The plugs for the A128 module are 5-way plugs with push-in 
spring technology, i.e. you can insert a solid wire or a fine-
stranded wire with a wire-end sleeve directly without screwing 

(max. 1.5 mm2). With a screwdriver press on the white opener to 
remove the connection. 

Fig. 4-88 Pin assignment and plugs for the Q.bloxx module A128.

U
2, 7 (+)

4, 9 (–)

1
0

1
1
0

1
P

lu
g

 1
P

lu
g

 2

1 NC
2 AIn 1+
3 NC
4 AIn 1–
5 NC
6 NC
7 AIn 2+
8 NC
9 AIn 2–
10 NC

1 NC
2 AIn 3+
3 NC
4 AIn 3–
5 NC
6 NC
7 AIn 4+
8 NC
9 AIn 4–
10 NC
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Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 135.

 4.22.1 Voltage

You can measure voltages of up to ±1200 VDC. Here, various 

input voltage ranges from ±40 VDC to ±1200 VDC are possible.

Voltages above 1200 V can damage the module.

Each module is tested with a test voltage of 5 kVDC for one min-

ute. A longer duration or a higher voltage can damage the mod-
ule. In addition, each period of overvoltage reduces the service 
life of the module.

Fig. 4-89 A124, voltage measurement.

IMPORTANT
Voltages which exceed the admissible limits give incorrect mea-
surement data, because the input voltage is internally limited.

U
2, 7 (+)

4, 9 (–)
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4.23 Q.bloxx D101: Connecting I/O

The Q.bloxx Module D101 has eight digital inputs and eight digi-
tal outputs. The pin assignment of the two connector strips is 
identical and the connection terminals have numbers for identify-
ing the connections. You will find the associated figures in each 
case at the same place in the circuit diagrams, for example each 
of the figures quoted in the second place belong to one possible 
connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections.

Fig. 4-90 Pin assignment for Q.bloxx Module D101.

 4.23.1 Digital input and output

On each connecting plug contacts for four inputs and four out-
puts are available. Since the inputs and outputs of this module 
are electrically isolated from the supply voltage, you must also 
connect 0V for the inputs and 0 V and a supply voltage (+V) for 
the outputs.

Input Output

Din Dout
6, 7, 8, 9

+V

10 (0V)

1

10 (0V)

2, 3, 4, 5
+V

1 +V
2 DOut 1
3 DOut 2
4 DOut 3
5 DOut 4
6 DIn 1
7 DIn 2
8 DIn 3
9 DIn 4
10 0 V

1 +V
2 DOut 1
3 DOut 2
4 DOut 3
5 DOut 4
6 DIn 1
7 DIn 2
8 DIn 3
9 DIn 4
10 0 V

1
0

1
1

0
1

P
lu

g
 1

P
lu

g
 2

+V must be between 12 V and 30 V
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Fig. 4-91 D101, digital input and output.

The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.

The following table shows possible combinations of contact 
assignments for the inputs:

1) e.g. counter with additional input for counting direction or 2-phase counter signals or fre-
quency measurement with direction detection (torque transducers)

2) e.g. counter with additional inputs for counting direction, zero reference and reset/enable 
for zero reference

3) e.g. sensors with binary coding

The following block diagrams give you an overview of the possi-
ble circuits.

Input Output

Din Dout
6, 7, 8, 9

+V

10 (0V)

1

10 (0V)

2, 3, 4, 5
+V

 Plug.Contact

 1.6 1.7 1.8 1.9 2.6 2.7 2.8 2.9

Status Status Status Status Status Status Status Status

Status Status Status Status Status Status 2-channel signal1)

Status Status Status Status 2-channel signal1) 2-channel signal1)

Status Status Status Status 4-channel signal2)

Status Status 2-channel signal1) 2-channel signal1) 2-channel signal1)

Status Status 2-channel signal1) 4-channel signal2)

2-channel signal1) 2-channel signal1) 4-channel signal2)

2-channel signal1) 2-channel signal1) 2-channel signal1) 2-channel signal1)

4-channel signal2) 4-channel signal2)

8-channel signal3)
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Measurement of status, time, frequency or PWM 
(Pulse-Width Modulation), 1 signal

Up/down counter or measurement of frequency and direction with 

static direction signal, 2 signals

Measurement of frequency and direction or up/down counter with 

2-channel frequency signal (90° phase delay)

Measurement of frequency and direction or up/down counter with 

4-channel frequency signal

Din
0V

Din

+/-

0V

Din

0V

Din

Index

Index 
enable

0V
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4.24 Q.bloxx D104: connecting digital inputs

The Q.bloxx Module D104 has sixteen digital inputs. The pin 
assignment of the two connector strips is identical and the con-
nection terminals have numbers for identifying the connections. 
You will find the associated figures in each case at the same place 
in the circuit diagrams, for example each of the figures quoted in 
the second place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections, NC indicates “not assigned”.

Fig. 4-92 Pin assignment for Q.bloxx Module D104.

 4.24.1 Digital input

On each connecting plug contacts for eight inputs are available. 
Since the inputs of this module are electrically isolated from the 
power supply, you must also connect 0 V and a supply voltage 
(+V).

Fig. 4-93 D104, digital input.

Din
2, 3, 4, 5, 6, 7, 8, 9

+V

10 (0V)

1 NC
2 DIn 1
3 DIn 2
4 DIn 3
5 DIn 4
6 DIn 5
7 DIn 6
8 DIn 7
9 DIn 8

10 0 V

1 NC
2 DIn 1
3 DIn 2
4 DIn 3
5 DIn 4
6 DIn 5
7 DIn 6
8 DIn 7
9 DIn 8

10 0 V

1
0

1
1

0
1

P
lu

g
 1

P
lu

g
 2

+V must be between 12 V and 30 V

Din
2, 3, 4, 5, 6, 7, 8, 9

+V

10 (0V)
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The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.
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4.25 Q.bloxx D105: connecting digital outputs

The Q.bloxx Module D105 has sixteen digital outputs. The pin 
assignment of the two connector strips is identical and the con-
nection terminals have numbers for identifying the connections. 
You will find the associated figures in each case at the same place 
in the circuit diagrams, for example each of the figures quoted in 
the second place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections.

Fig. 4-94 Pin assignment for Q.bloxx Module D105.

 4.25.1 Digital output

On each connecting plug contacts for eight outputs are available. 
Since the outputs of this module are electrically isolated from the 
power supply, you must also connect 0 V and a supply voltage 
(+V) for the outputs.

Fig. 4-95 D105, digital output.

Dout
10 (0V)
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1 +V
2 DOut 1
3 DOut 2
4 DOut 3
5 DOut 4
6 DOut 5
7 DOut 6
8 DOut 7
9 DOut 8

10 0 V
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2 DOut 1
3 DOut 2
4 DOut 3
5 DOut 4
6 DOut 5
7 DOut 6
8 DOut 7
9 DOut 8

10 0 V

1
0

1
1

0
1
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lu

g
 1
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g
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+V must be between 12 V and 30 V

Dout
10 (0V)

1

2, 3, 4, 5, 6, 7, 8, 9
+V
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4.26 Q.bloxx D107: Connecting digital inputs

The Q.bloxx Module D107 has sixteen digital inputs. The pin 
assignment of the two connector strips is identical and the con-
nection terminals have numbers for identifying the connections. 
You will find the associated figures in each case at the same place 
in the circuit diagrams, for example each of the figures quoted in 
the second place belong to one possible connection method.

The designations 0 V (GND) and +V refer to the supply voltage 
connections for supplying the sensors. NC signifies “No Connec-
tion”. Both terminals are electrically isolated from one another 
and from the module supply voltage.

Fig. 4-96 Pin assignment and circuit variants for the Q.bloxx Mod-
ule D107.

 4.26.1 Digital input

On each connecting plug contacts for three inputs are available. 
You can use the inputs as a differential input or as a ground-ref-
erenced (single-ended) input. Since in each case the inputs termi-
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nals are electrically isolated from one another and from the sup-
ply voltage, you also have to connect GND (0 V) even with 
differential inputs.

A supply voltage (+V) of 5 V and max. 150 mA per terminal is 
available for supplying the connected sensors.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold. In the differential measurement 
mode the threshold can be set in 256 steps between -20 V and 
+20 V, otherwise between 0 V and +26 V.

The following table shows possible combinations of contact 
assignments for the inputs on Plug 1 (Dx = Sensor x):

1) e.g. status input, frequency measurement or counter
2) e.g. counter with additional input for counting direction (forwards/reverse counter) or 2-

phase counter signals (quadrature counter) or frequency measurement with direction de-
tection (torque transducers)

3) e.g. 2-phase counter signal or angle sensor with additional input for zero reference

The following illustrations show examples for the connection of 
various sensors. Here, in each case only one sensor and one vari-
ant is shown. For example, for the sensor in Fig. 4-98 or Fig. 4-99 
you can also use connections 5/6 and 8/9 and the connections 2/3 
for a standard sensor or digital input. The connection of a single 
digital input is not considered in illustrations. If your are connect-
ing more than one sensor per terminal, you can mix ground-refer-
enced and differential configurations.

Operating mode

 Plug.Contact (assignment)

 1.2
(A1+)

1.3
(A1‒)

1.5
(B1+)

1.6
(B1‒)

1.8
(Z1+)

1.9
(Z1‒)

1.10
(0 V)

3 x standard1), differential D11+ D11‒ D21+ D21‒ D31+ D31‒  GND

3 x standard, single-ended D11+ — D21+ — D31+ — GND

1 x 2 sensor signals2) + 
1 x standard, differential

D11+ D11‒ D12+ D12‒ D21+ D21‒ GND

1 x 2 sensor signals + 
1 x standard, single-ended

D11+ — D12+ — D21+ — GND

1 x 3 sensor signals3), dif-
ferential

D11+ D11‒ D12+ D12‒ D13+ D13‒  GND

1 x 3 sensor signals, sin-
gle-ended

D11+ — D12+ — D13+ — GND
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Fig. 4-97 D107, sensor with one signal, single-ended or differential 
(input broken line).

Fig. 4-98 D107, sensor with two signals (counting direction), sin-
gle-ended or differential (input broken line).

Fig. 4-99 D107, sensor with two signals (90° offset), single-ended 
or differential (input broken line).

Fig. 4-100 D107, sensor with three signals (2 x 90° offset and zero 
reference), single-ended or differential (input broken 
line).
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5 Configuration

You must first establish contact with the module before you can 
configure it. Use the program test.commander for this purpose if 
a Q.gate- or a Q.pac Test Controller is present. Otherwise, use 
the program ICP 100 for the configuration. 

A license number is needed which you have to enter to be able to 
save configurations. During the installation of test.commander, 
the software ICP 100 is also installed and, with the licensing of 
test.commander, is also enabled. You will find the license num-
bers in the PDF file enclosed with the supplied items and on the 
separate printout with your license data.

The manuals and online help for the programs provide a compre-
hensive description of all program options. The following 
describes the most important settings to obtain a system suitable 
for acquiring measurements.

Tip
Use the test.commander Wizard for the initial setup.

If you already have a configuration file with the required settings 
available, you can load this file into the relevant module with the 
Program Controller Setup Wizard (included in test.commander) 
or ICP 100.

IMPORTANT
If you would like to combine modules or Test Controllers from 
older applications and recently purchased ones, all components 
should use the latest relevant internal software, the so-called 
firmware. To ensure this, carry out a firmware update; refer to 
Section 5.10, page 132.

Basic procedure

• Establish the connection (communication) between the PC 
and module or Test Controller.

• Start the configuration program.

• Enter the sensors used and their sensitivities to obtain an 
indication in the measured physical quantity.

• Define computations, digital inputs/outputs, alarm monitor-
ing, etc.

• Activate all settings in the module and Test Controller.
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Tip
At many points in the programs you can call the setting dialogs or 
settings via the context menu of an entry. You call the context 
menu with the right mouse key.

5.1 Installing the test.commander

➡ We recommend that you close all open programs before the 
installation.

Insert the Gantner CD into your CD drive. In the standard config-
uration Windows opens the CD automatically and a start window 
appears. If you have deactivated the Windows autostart function, 
find the file StartUp.exe in the main directory on the CD and give 
the corresponding symbol a double click to obtain the start win-
dow. Alternatively, you can also start the program Setup.exe in 
the folder test.commander to carry out the installation directly.

➡ The program ICP 100 is installed together with the program 
test.commander.

You will also find the relevant latest versions of the programs on 
our home page www.gantner-instruments.com via Software > 
Download.

Procedure • Click on the symbol over Load software.

• Click on the symbol  next to the program which you 

want to install.

The program Setup.exe is started.

• Allow the file to open so that the installation can start.

The starting dialog of the setup program appears. 

• Follow the instructions of the setup program to define the 
installation directory and the program group for the software.

Setup.exe creates the directory you have specified, if neces-
sary and then copies all files to it.

When the program test.commander is started for the first time, 
you specify the language for the program user interface (you can 
change your selection at any time via Extras > Settings > Lan-
guage). 

Then enter your license data via Help > Info and Licensing. If 
you have licensed the program test.commander, then the pro-
gram ICP 100 is also enabled and a further license is not 
required.

http://www.gantner-instruments.com
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5.2 Using test.commander

You can use the program test.commander, when a Q.gate or 
Q.pac Test Controller is present in your configuration. For the 
configuration no module or Test Controller needs to be con-
nected; you can carry out the configuration also off-line. For ini-
tial operation we recommend though that all modules are con-
nected. Since when using Test Controllers more than one module 
is usually present, you must namely also specify the addresses of 
the individual modules if this does not take place through the DIP 
switches in the module bases (refer to Section 4.1.2, Setting the 
address (optional) on page 23). The procedure for setting 
addresses via software is described in Section 5.2.1.

5.2.1 Linking test.commander via Ethernet (TCP/IP)

In order to be able to communicate with the Q.bloxx modules via 
Ethernet, you need to have a Q.gate or Q.pac Test Controller 
available to which the relevant modules are connected.

Tip
Use the serial interface (refer to Section 5.2.2, page 105), if a 
permanent IP address (no DHCP) has already been set on the 
Q.gate or Q.pac Test Controller, but you no longer know what it 
is. Other than that, you cannot establish any link between the 
module and PC with “incorrect” address ranges.

Procedure 1. Connect the PC and Q.gate or Q.pac Test Controller via the 
Ethernet interface.

2. Start the program.

Now you have two options: Either you can use the Initial 
Operation Wizard or you can close the starting dialog with 
Cancel and proceed as described in the following. If you want 
to use the wizard, then simply follow the instructions in the 
dialog.

3. Call the program for configuration via the menu Utilities > 
Module Setup Wizard.

4. In the program window and using the menu Options > Com-
munication settings, specify the setting TCP/IP via con-
troller as the Interface type and activate Use scan for IP 
addresses.

For the Ethernet address you can either execute a scan in the 

address range of the PC interface (a UDP Scan1 is executed) 
or directly enter a single address of Q.gate or Q.pac. If 

1) With the UPD Scan all devices in a network are addressed simultaneously. The scan is therefore 

executed very quickly.
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required, ask the network administrator to enable these scan 
methods and access of the program through the firewall to 
the Test Controllers.

If you use, e.g. 15 seconds, for the Add. (itional) timeout, an 
attempt to establish connection is interrupted after this 
period. The option only needs to be used for very slow net-
works or links via radio, etc.

5. Search for the modules: Find modules.

If you receive a firewall message during the search, you have 
to allow access to the Program Setup Wizard in order to be 
able to establish a connection (requires administrator rights), 
refer also to Section 6.2.3, Allowing access to network 
devices (firewall), page 141.

First the Test Controllers found are displayed after the 
search. Mark the Test Controller to which the modules to be 
set are connected and click on OK. The Test Controller is 
addressed and the modules which have been found connected 
to it are displayed in a list. If there are addressing conflicts, 
you obtain a warning and the relevant modules are high-
lighted in red in the list. In this case click the column with the 
address and select a different address if you are assigning 
addresses via software. Assign unique addresses to all mod-
ules and click on Write changes. Having made the change, 
again execute Find modules. 

Tip
Assign the addresses starting with a number higher than 1, e.g. 
starting with 3. You can then integrate new modules more easily 
later, because the factory setting of the address in the modules is 
always 1.

If the addresses have been configured via the DIP switch in 
the base, when address conflicts occur, check the settings 
(Section 4.1.2, Setting the address (optional), page 23).

If files with the module settings exist, you can transfer them to 
the marked modules using Configure selected modules. Other-
wise, create a project for the configuration (Section 5.2.3).

IMPORTANT
If, when reading out the module settings via the Test Controller 
(step 5.), the message appears that the firmware version of the 
Test Controller or of a module is older than expected, then you 
should carry out a firmware update; refer to Section 5.10, Firm-
ware update, page 132.
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5.2.2 test.commander and the serial (service) interface

test.commander uses the serial interface exclusively as a service 
interface for the Q.gate Test Controller or Q.pac Test Controller 
to set the IP address for Ethernet. Setting connected modules is 
not possible via this interface. 

Procedure 1. Connecting the PC and module via the interface.

Use the supplied cable with the jack plug for the connection 
to the PC interface; refer also to Section 4.4.4, page 35.

2. Start the program1.

3. Using the menu Utilities, call the menu item Controller 
Setup Wizard.

4. In the program window using the menu Options > Commu-
nication Settings, specify the setting RS232 direct con-
nection as the interface type as well as the PC COM port 
used.

5. Call the program for the settings via the menu Utilities > 
Controller serial terminal.

The program searches the above specified interface for the 
Test Controller and presents you with a dialog in which you 
can read out the existing settings (Read) or set a new Ether-
net address (and subnet mask) or DHCP (Write).

1) If you are not initially creating a project, close the starting dialog with Cancel.
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5.2.3 Creating a project for configuration

A project contains the hardware setup, the sensor and I/O set-
tings present in the modules as well as the sensor signals used 
and computations, the so-called variables, which are to be output.

Procedure 1. After the start of the test.commander you are offered several 
options. Select Open new project and read in online sys-
tem.

The network to be searched is defined when the link is estab-
lished; refer to Section 5.2.1 to Section 5.2.2, ff. page 103.

Alternatively, you can also create a project in the test.com-
mander with File > New project and specify the Test Con-
troller used via the context menu Add online controller.

2. In the dialog mark the Test Controller to which the modules to 
be set are connected and click on OK.

The existing module settings are read out and the Test Con-
troller information updated via the connected modules. Con-
firm any changes to be made in order to retain the current 
state.

3. A dialog finally shows you that all settings have been success-
fully read from the Test Controller. Acknowledge this with a 
click on OK.

In your project the selected Test Controller is now displayed as 
the main entry. A tree structure similar to that in Windows 
Explorer shows the connected (found) Q.bloxx modules and the 

variables used. Open up the entries as required by a click on .

Mark a module and select Configuration from the context menu 
or double click on a module or signal (variable) to start the con-
figuration program ICP 100. Then carry out all the module set-
tings in the window of this program.

IMPORTANT
After changes to the configuration of modules or a Test Con-

troller  is displayed in the project tree. Select  or File > 
Write project (update) in the test.commander to update the 
settings in the project (and in the Test Controller). The project 
file is in this case automatically saved. 

Tip
You process a complete variable in the configuration dialog in 
that you click on the variable in the left column (contains the vari-
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able number Vx) to mark it. Using the context menu, you can then 
cut, paste and copy the variable, overwrite it with a copied vari-
able or delete it.

5.3 Configuring analog inputs

5.3.1 Setting sensor parameters

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.

Fig. 5-1 Dialog with the configuration for force transducers (6-
wire) and voltage input.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Analog. Input.

3. Click in the column Variable name and allocate a name iden-
tifying the signal from the connected sensor.

4. Click in the column Sensor and specify the type of sensor.
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Depending on the type of module, you have various options 
available, e.g. Bridge for strain-gauge full and half-bridges, 
Pt100, Resistance for resistors or Voltage for voltage mea-
surements and IEPE sensors.

5. Click in the column Type of and specify the type of circuit or 
further information about the sensor type.

Depending on the selected sensor type, you have various 
options available, e.g. 2-wire or 4-wire (circuit) for resistive 
transducers or Full 4-wire or Full 6-wire (circuit) for strain-
gauge full bridges.

The column Wiring diagram shows you the pin assignment 
to be used. With more than one input the first inputs are also 
always occupied first (and first Plug 1, then Plug 2, etc.). 
Check that your sensor is connected correctly.

6. Click in the column Format/balance to enter the scaling for 
the sensor.

Depending on the type of sensor selected, you have various 
options available (refer also to Section 6.4, Sensor scaling, 
page 144):

– For voltage signals specify the conversion of the measured 
voltage to the physical quantity measured by the sensor or 
output the measured voltage quantity without conversion 
(scaling).

– For thermocouples or Pt100 sensors no further scaling is 
required as the conversion into °C is made automatically. 
The scaling is only needed when you want to convert to °F 
or K. In this case enter the Unit (type into the field) and 
then click on Scaling. Using the method Factor and off-
set. For a display in °F enter the factor 1.8 and 32 as the 
offset. For a display in °K enter the factor 1 and -273.15 
as the offset.

– For full and half-bridge transducers you can obtain the 
data from the data sheet or (better) from the transducer 
calibration certificate. For a force transducer with, for 
example, 2.03mV/V at 5kN enter the Unit (type kN in the 
field) and then click on Scaling. Using the method 2-
point calibration. Enter in each case 0 for Point 1 for 
Measurement and Displayed value and 2.03 as Mea-
surement and 5 as Displayed measurement for Point 
2.

Alternatively, you can also enter N as Unit and then 5000 
as Displayed value for Point 2.

– For strain gauges you have the Strain gauge calculator 
available. Here, the unit is automatically changed to μm/
m. In the dialog enter the gauge factor of your strain 
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gauge (left field) and the bridge factor (right field) for 
your circuit.

Floating point numbers are always transferred as 4-byte val-
ues and further setting is not necessary here.

For the formats Integer (2 bytes) and Long integer (4 bytes) 
specify the number of Decimal places and the total number 
of places to be output (Field length). The field length is cal-
culated including the points, but without any commas dis-
played for the thousands positions and it is only used for rep-
resentation in one of the Gantner programs. Specifying three 
decimal places displays, for example, the value 1234 as 1,234.

After closure of the dialog the number of transferred places 
and the unit are displayed in the column Format/balance, 
e.g. ff,fff.f [kN] for an output in the unit kN with a total of 
seven characters with one decimal place and the decimal 
point.
If negative numbers occur, the display in this example is lim-
ited to -9,999.9 (seven characters without the comma).

7. Click in the column Range/error to limit the admissible value 
range and to define the reaction in the case of an error 
(optional).

8. Also optionally, you can specify filtering of the sensor signal 
in the column Other.

9. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.

IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
> Write project (update) in the test.commander. The project 
file is in this case automatically updated.

5.3.2 Carrier frequency synchronization (Q.bloxx A106)

The A106 module supports the supply of sensors with direct volt-
age (DC) or carrier frequency (CF).

➡ If you are using several modules of this type and set carrier fre-
quency supply, you should synchronize the carrier frequencies of 
the modules, because otherwise crosstalk can occur between the 
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supply lines and the signal inputs of different modules. This then 
leads to beats in the measurement signal.

After selecting a carrier frequency, you have three methods of 
supply:

1. No sync.(hronization)

This setting is practicable when you are only using one mod-
ule with carrier frequency supply. Within a module all carrier 
frequency generators are automatically synchronized.

2. Internal sync.(hronization)

Set this type of synchronization for one module. The module 
then becomes the master to which all other modules synchro-
nize.

3. External sync.(hronization)

Specify this type of synchronization for all other modules so 
that they synchronize to the master.

For synchronization the Sync A and Sync B lines in the socket are 
used (Fig. 4-6, page 29).

Tip
We recommend that only one variant of the carrier frequency is 
used, i.e. do not mix 600 Hz and 4800 Hz.

Do not forget to save these settings in the module and the Test 
Controller (refer to Section 5.3.1, Setting sensor parameters, 
page 107).

5.3.3 Zero balancing/taring the sensor

You have two ways of setting a measurement offset to zero, e.g. 
due to preloads:

1. Zero balance

With this method measurement takes place over a certain 
time period and the mean is computed. This mean value is 
then subtracted from all the following measurements.

2. Taring

With this method the (single) measurement present at a cer-
tain point in time is subtracted from all the following mea-
surements.

You can, for example, perform the zero balance when setting up 
or control it using a variable.
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Procedure
(control using a variable)

1. Click in the column Type of the first free row (V3 = Variable 3 
in Fig. 5-2) or mark the row (click on V3) and use Variable 
definition > Type.

2. Select Default.

3. Click in the column Variable name and allocate a name spec-
ifying the purpose of the signal, e.g. Zero_tare (Fig. 5-2).

Fig. 5-2 Defining the variable for zero balancing and/or taring.

4. Click in the column Format/balance of the channel for which 
zero balancing and/or taring is to be executed, e.g. for the 
strain-gauge force sensor in Fig. 5-2.

Fig. 5-3 Dialog for sensor scaling.

5. Click on Direction and specify Input/Output for the channel 
so that control is possible (Fig. 5-3).

6. Click on Zero balance or Tare to configure the relevant pro-
cess (Fig. 5-3).

7. Select the variable created above as the control variable 
(Fig. 5-4).
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Fig. 5-4 Setting up zero balance or tare.

When the variable (Zero_tare in this example) has certain values, 
taring or zero balancing is carried out or an existing zero or tare 
value is deleted (undo zero balancing/taring):

Do not forget to save these settings in the module and the Test 
Controller (refer to Section 5.3.1, Setting sensor parameters, 
page 107).

5.3.4 Sensor scaling over several points (table)

In the standard setting (linear) sensors are scaled via a charac-
teristic curve with two points. You can however also perform scal-
ing over several points (table). During the measurement the val-
ues are then linearly interpolated between the specified points.

Procedure 1. Create the sensor as usual (two-point scaling).

2. In the Sensor column click on the sensor.

3. Copy the sensor (click on Copy) and specify a name, e.g. 
ForceTable (Fig. 5-5). If the scaling to be entered later only 
applies to this sensor, you should use the sensor type and the 
serial number as the name, e.g. C2 #1234 (5V).

Value Function

1 Perform taring when setting the value

2 Reset tare (delete tare value)

4
Start zero balance The mean is formed until the value 0 
is written to the variable again.

8 Reset zero balance (delete zero value)
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Fig. 5-5 Creating a new sensor for scaling.

4. Click on Edit and the Unit tab to be able to define the unit 
measured by your sensor (Fig. 5-6).

Fig. 5-6 Defining the unit for sensor scaling.

5. Specify the required unit, e.g. kN (Fig. 5-6).

6. Click on Linearize and select your unit.

7. Edit the existing values or generate further rows with New 
and specify the values for your sensor (Fig. 5-7). The rows are 
sorted based on the entered values.
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Fig. 5-7 Entering the scaling table.

If the data are present in an Excel file, you can also import a file 
in the format Excel 97-2003-Workbook (*.xls).

Alternatively to entering a unit in step 5, you can leave the elec-
trical unit of the sensor as it is and enter the table in this unit, 
e.g. mV/V measured value and mV/V displayed value. You can 
then define the unit displayed for the measurement in the For-
mat/balance column.

Do not forget to save these settings in the module and the Test 
Controller (refer to Section 5.3.1, Setting sensor parameters, 
page 107).

5.4 Specifying digital inputs/outputs

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.
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Fig. 5-8 Dialog with configuration for digital input and output.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Digit. input or Digit. output.

The column Wiring diagram shows you the pin assignment. 
With more than one input the first inputs are also always 
occupied first (first Plug 1, then Plug 2, etc.). Check for cor-
rect connection.

3. Click in the column Variable name and allocate a name iden-
tifying the signal.

4. At a digital output click in the column Type of and specify 
whether you want to use the output as Status indicator, Sta-
tus field or Process output. 

Process output: The output monitors a module signal and 
changes the output level under certain conditions. Click in the 
column Other and specify the type of alarm monitoring.

You can specify up to four alarm conditions. When one of 
the conditions is satisfied, the alarm signal is triggered. 

To the left above the graphical displays select the levels at 
which switching is to occur and how they are to switch. 
Enter the values for the switching thresholds in the 
(scaled) unit of the selected signal. Use either fixed values 
(constants) or arrange for the values to be determined by 
other variables.

Status indicator: The output can be set via a command from 
the Test Controller, e.g. via a PROFIBUS-DP command. Click 
in the column Other and specify the type of alarm monitoring.

5. Click in the column Format/balance to specify the transfer 
format.
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Since digital signals do not require any Decimal places, you 
can enter 0 here. 1 is sufficient for the Field length. With a 
digital input you can also specify a unit (optional).

For several inputs/outputs and the type Status field (Type of 
column), as well as the transfer as a number (e.g. as integer), 
there is also the type Status field 32 with which all existing 
inputs or outputs are transferred as binary numbers. Define a 
suitable field length here depending on the number of inputs 
and outputs.

When the dialog is closed, the number of transferred places 
and the unit in the column Format/balance are displayed.

6. Click in the column Range/error to define the reaction in the 
case of an error for the digital outputs (optional).

7. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.

IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
> Write project (update) in the test.commander. The project 
file is in this case automatically updated.

5.5 Configuring analog outputs

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.
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Fig. 5-9 Dialog with configuration for analog outputs.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Analog. Output.

The column Wiring diagram shows you the pin assignment. 
With more than one output the first outputs are also always 
occupied first (first Plug 1, then Plug 2, etc.). Check for cor-
rect connection.

3. Click in the column Variable name and allocate a name iden-
tifying the signal.

4. Click in the column Type of and specify whether you want to 
use the output as a Voltage or a Current output. 

5. In the Format/balance column the output format is shown 
which has no further significance here.

6. Click in the column Range/error to define the output scaling 
and the reaction in the case of an error (optional).

7. Click in the column Other to specify the signal source (vari-
able) used for the output.

8. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.

IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
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> Write project (update) in the test.commander. The project 
file is in this case automatically updated.

5.6 Defining computations

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.

Fig. 5-10 Dialog with configuration for a computation.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Arithmetic.

3. Click in the column Variable name and allocate a name iden-
tifying the signal.

4. Click in the column Other and specify the required computa-
tion.

In the upper dialog field you can enter, as on a pocket calcula-
tor, a formula which uses the existing module variables. Cre-
ate functions via the buttons in the lower section of the dialog. 
Click on OK once you have defined the required computation.
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5. Click in the Format/balance column to specify the transfer 
format using the formats Integer (2 bytes) and Long integer 
(4 bytes).

Floating point numbers are always transferred as 4-byte val-
ues and further setting is not necessary here.

For the formats Integer and Long integer specify the num-
ber of Decimal places and the total number of places to be 
output (Field length). The field length is calculated including 
the points, but without any commas displayed for the thou-
sands positions and it is only used for representation in one of 
the Gantner programs. Specifying three decimal places dis-
plays, for example, the value 1234 as 1,234.

After closure of the dialog the number of transferred places 
and the unit are displayed in the column Format/balance, 
e.g. ff,fff.f [kN] for an output in the unit kN with a total of 
seven characters with one decimal place and the decimal 
point.
If negative numbers occur, the display in this example is lim-
ited to -9,999.9 (seven characters without the comma).

6. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.

IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
> Write project (update) in the test.commander. The project 
file is in this case automatically updated.

5.7 Specifying the alarm monitoring

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.
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All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.

➡ In order to monitor a limit and to output a level on a digital output 
when an alarm occurs, you can directly use the function of the 
digital output. You do not need to set up any alarm monitoring. 
The alarm monitoring is used to monitor signals in the module 
and to make the result available to the PC or PLC as a precondi-
tioned signal. Checking the original signal in the PC or PLC can 
therefore be omitted.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Alarm.

3. Click in the column Variable name and allocate a name iden-
tifying the alarm signal.

4. Click in the column Other and specify the type of alarm mon-
itoring.

You can specify up to four alarm conditions. When one of the 
conditions is satisfied, the alarm signal is triggered. 

To the left above the graphical displays select the levels at 
which switching is to occur and how they are to switch. Enter 
the values for the switching thresholds in the (scaled) unit of 
the selected signal. Use either fixed values (constants) or 
arrange for the values to be determined by other variables.

5. Click in the column Format/balance to specify the transfer 
format.

Since the alarm signal, like digital signals, does not require 
any Decimal places, you can enter 0 here. 1 is sufficient for 
the Field length.

When the dialog is closed, the number of transferred places 
and the unit in the column Format/balance, e.g. f, are dis-
played.

6. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.
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IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
> Write project (update) in the test.commander. The project 
file is in this case automatically updated.

5.8 Q.gate and Q.pac settings

In the Test Controller you specify, for example, the type and 
scope of the synchronization, set the (synchronous) output rate 
and baud rate of the modules to be used or define which bus diag-
nostic data or life signs are to be transmitted. In addition, you can 
check all the settings of host and module interfaces, allocate a 
location name, etc. The following sections only deal with the most 
important settings; for further information read the appropriate 
Test Controller manual.

Mark the Test Controller to be set and select Settings from the 
context menu or double click on the Test Controller to start the 
configuration program. Then you can carry out all the module 
settings in the window of this program. A tree structure similar to 
that in Windows Explorer shows the individual parameter groups. 

Open up the entries as required by a click on .

Fig. 5-11 Configuration dialog for a Q.gate. Test Controller

5.8.1 Module interface

Using this parameter group you specify the speed of the data 
transmission on the individual interfaces (UARTs). The maximum 
possible speed depends on the overall length of the cable which is 
connected to the relevant interface.
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A change in the baud rate is also carried out automatically on the 
modules connected to the interface.

Communication monitoring: With a value > 0 the module 
error LED is activated if there is a lack of communication after 
this period.

Response delay: This parameter is only needed when the mod-
ules are not directly connected to this interface, but instead con-
nected to a modem, for example. Then enter the time here which 
is to be awaited additionally due to the slow connection.

5.8.2 Host interface

This parameter group defines the settings for communication 
with the host(s) (other Test Controllers, PC, PLC, etc.). Refer also 
to Time synchronization, page 123 (Section 5.8.3.3).

Since the Test Controller can also operate as an FTP server and 
FTP client, the settings for sending e-mails, for example, can also 
be defined here. Further information on these parameters can be 
found in the System Guide Manual.

5.8.3 Settings

Using this parameter group you define, for example, life signs or 
the location name. The parameters available are different for the 
Q.gate and Q.pac; the parameters only available with the Q.pac 
are appropriately labeled.

5.8.3.1 General remarks

Location Here, assign a name for the Test Controller.

PAC functionality
(only Q.pac)

Activates or deactivates the PAC functionality. With active PAC 
functionality only two ring buffers maximum (refer to 
Section 5.8.3.4, page 125) are available. The PAC functionality 
enables you to program more complex functions such as PID con-
trollers, function generators, etc. via the software e.con, which 
can be  graphically programmed.

Cable length in meters Maximum baud rate

1000 < 500 kBaud

100 < 1500 kBaud

20 < 6000 kBaud

10 >6 to 48 MBaud
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Buffer pre-initialization In the Fast filling default setting each measurement transferred 
with a bit error leads to an error: the measurement is set to -1 
(default setting for Filling pattern) and the error counter is set. 
This generally causes the test-rig to stop. In the setting Deacti-
vated the previous measurement is also used for the present 
measurement. If the next measurement is alright again, measure-
ment continues as normal. The error is however counted, but no 
alarm is triggered.

Filling pattern Value which is used for a defective measurement (refer to Buffer 
pre-initialization).

5.8.3.2 Life sign

Here you specify the communication errors for which an error 
signal is to be set and whether it is to occur as a static signal or 
dynamically (switching between on and off with the I/O status 
cycle).

5.8.3.3 Synchronization

Synchronous sampling fre-

quency

If you are using several modules on various interfaces (UARTs), 
which operate at different sample rates, for example because not 
all modules support the same sample rate, then with this parame-
ter you can ensure that those values transferred over an interface 
(UART) with a slow sample rate are also synchronized to the time 
points at which a measurement is also present that has been 
acquired with a fast sample rate (Fig. 5-12).

Fig. 5-12 Data transmission at a synchronous sampling frequency. 

When using several Q.pac Test Controllers, additionally specify 
which is used as master (Use as master: Yes) and which are 
used as slaves The master (only one master is permissible) 
defines the synchronization and then all slaves synchronize them-
selves to the master. 

Time synchronization If you want to use either several systems or to synchronize your 
system through an external time source, you must specify how 
the synchronization is to occur (refer also to Section 4.5, 
page 38).

Sample rate 1

Sample rate 2, not 
synchronized

Sample rate 2, 
synchronized
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1. Synchronization of several Q.pac Test Controllers through 
one sync line

Connect the sync connections of the Test Controller through 
synchronization lines (plug-in terminal 2, connections 9 and 
10; refer to Section 4.4.2, page 32). For this purpose use a 
screened cable with twisted cores if possible. One (any) con-
troller becomes the master; on this controller set Settings > 
Synchronization > Sync. protocol settings to None. For 
the other Test Controllers specify Q.sync over RS485 as the 
setting in the same dialog.

The maximum length of all synchronization lines together is 
1000 m.

2. Synchronization of a Q.pac Test Controller through a radio 
receiver for time signals

Connect the receiver either via the digital IOs or via RS-485; 
refer to Section 4.5.1, page 41. Depending on the connection 
and output signal, specify AFNOR via IOs, AFNOR via 
RS485, IRIG B003/B005 via IOs or IRIG B003/B005 via 
RS485 for Settings > Synchronization > Sync. protocol 
settings. The maximum length of the lines for connection via 
IOs is 3 m.

3. Synchronization of a Q.gate or Q.pac Test Controller through 
a GPS receiver

Connect the GPS receiver with the RS-232 interface of the 
Test Controller and specify NMEA-0183 for Host interface 
> RS 232 > Protocol.

4. Synchronization of a Q.gate or Q.pac Test Controller through 
SNTP

Make sure that the Test Controller can access a time server in 
the Ethernet network. Specify On for Host interface > 
SNTP > SNTP mode as well as the Server address (IP 
address of the time server).

All other variants are combinations of theses four methods:

1. Synchronization of several Q.pac Test Controllers through 
one sync line; the master controller can be synchronized 
through radio receiver for time signals, a GPS receiver or 
SNTP.

Set the master up as described above (Settings > Synchro-
nization > Sync. protocol settings remains on None). On 
the slave controllers specify Q.sync over RS485 for Settings 
> Synchronization > Sync. protocol settings. With a radio 
receiver for time signals in this case only the digital IOs can 
be used for the input.

2. Synchronization of several Q.pac Test Controllers through a 
radio receiver for time signals (without sync line)
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Connect the time signal directly on all Test Controllers to the 
digital IOs (plug terminal 2, connections 9 and 10; refer to 
Section 4.4.2, page 32). Depending on the output signal, 
specify AFNOR via IOs or IRIG B003/B005 via IOs for Set-
tings > Synchronization > Sync. protocol settings for all 
Test Controllers.

3. Synchronization of several Q.gates or Q.pac Test Controllers 
through SNTP (without sync line)

On all Test Controllers specify On for Host interface > 
SNTP > SNTP mode as well as the Server address (IP 
address of the time server).

5.8.3.4 Ring buffers

With Q.gate and Q.pac a ring buffer is available in each case. 
When reading data from the buffer, all the (new) data are 
retrieved which are present in the buffer. With the maximum buf-
fer size (16 Mbyte is available) the transfer may take some time. 
Reduce the buffer if data are retrieved from the buffer only spo-
radically or not much data is involved.

5.8.4 Storage settings (only Q.pac)

With Q.pac you can set up several data stores, but with active 
PAC functionality only a maximum of two. For the individual data 
stores specify the values which are to be recorded in these buf-
fers and with which timing pattern. For example, you can record 
only every 100th value. The file names are automatically formed 
from the memory number and date/time.

When a USB stick is inserted, the data written into the data 
stores are automatically transferred to the stick and, after suc-
cessful transfer, deleted in the Test Controller.

5.8.5 System variable

IMPORTANT
The system variable created in the default setting for the time or 
the cycle counter (Cyclecounter) must not be changed.

In the System Variables section specify further time variables if 
you would like to use time formats other than in the default sys-
tem time. Context menu for system variables Add new variable 
> ABSDATETIME. After a double click on the variable and a fur-
ther click on Formula you can then select other formats (Fig. 5-
13).
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Fig. 5-13 Dialog for specifying the time format.

5.8.6 Virtual variable

With virtual variables you can carry out computations, evaluate 
trigger conditions or carry out assessments. The variables can be 
output like measurements or linked to other variables, measure-
ments or digital I/Os.

In the context menu for virtual variables select Add new vari-
able > ARITHMETIC_EMPTY. After a double click on the vari-
able you can either specify a formula for the computation, define 
an event which is to be monitored (trigger) or specify the data 
format to be used (Fig. 5-14).
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Fig. 5-14 Configuration dialog for a virtual variable.

Click on, for example, Formula to enter a computation (Fig. 5-
15).

Fig. 5-15 Defining a computation (formula).
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In the dialog you have available all variables already defined (tab 
V1-10 and other tabs if more than ten variables have been 
defined). Click on one of the variables to insert it into the for-
mula. Use the field Functions and operators to select a mathe-
matical or logical function (select the function and click on 
Select function so that it is accepted into the formula field). 
Where required add brackets (simply enter them via the key-
board) in order to obtain the correct computational sequence. 
Close the dialog with OK.

IMPORTANT

Select  or File > Write project (update) in the test.com-
mander to transfer the new definition into the Test Controller. 
The project file is in this case automatically updated.
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5.9 Online tools

5.9.1 Read data buffer (with measurements) 

Click on  or use File > Read online data buffer from con-
troller to be able to read out and view all values from the ring 
buffer. 

Fig. 5-16 Display of the buffer content with test.viewer.

You can carry out further settings using the menu and symbols, 
e.g. display the channel list, show the spectra or transfer a live 
stream of data.

5.9.2 Displaying measurements

Click on  or use File > Read online values from control-
ler to be able to view the values of your variables. If you have 
defined appropriate variables, you can also set initial values in 
this dialog.
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Fig. 5-17 Dialog for displaying the variable values.

In the dialog click on Show online graphics to display the val-
ues in a graph over time.

5.9.3 Reading module information

Click on  or use File > Read online module info from 
controller to be able to display information such as the address 
or serial number of your system.

Fig. 5-18 Display of the module information.
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5.9.4 Reading status information

Click on  or use File > Read online status info from con-
troller to display status information of your system.

Fig. 5-19 Display of the status information.
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5.10 Firmware update

Recently purchased modules or Test Controllers always contain 
the latest firmware, i.e. the software in the modules or Test Con-
trollers is the current version. However, if you want to combine 
these modules with older modules and/or Test Controllers, you 
must update all older modules or Test Controllers and it is essen-
tial to update your software to the latest version, because other-
wise disturbances in operation due to a communication failure 
may occur.

The current firmware is in each case included in the latest instal-
lations of the programs ICP 100 or test.commander. Here, the 
program licenses apply to all versions of a program. If required, 
download the latest versions from our web site: www.gantner-
instruments.com. You will find the programs under Software > 
Download.

5.10.1 Firmware update for Test Controller

Install as required the latest version of the test.commander so 
that you can also install the latest version of the firmware on your 
PC. Before a new installation is carried out, we recommend that 
the existing version is uninstalled using the Windows Control 
Panel.

Procedure 1. In the program test.commander select Utilities > Controller 
firmware update.

The network in the segment of the PC address is searched and 
the Test Controllers which are found are displayed in the win-
dow. If no Test Controller is found, you may have to enter the 
address manually or set the IP address of your PC to the seg-
ment used by the Test Controller; refer also to Section 4.4.3, 
Connecting Q.gate/Q.pac via Ethernet to a PC/PLC, page 34.

2. Mark the Test Controller to be updated and click on OK.

The update tool is started and the Test Controllers present in 
the network are displayed again.

3. Mark the Test Controller to be updated and click on Update.

The Windows file dialog is opened and shows you the firm-
ware versions available on your PC.

4. Mark the newest of the available firmware versions (if neces-
sary, switch to the detailed view) and click on Open.

The update process is started. Wait until the update has fin-
ished. The end of updating is indicated by the dialog “Update 
completed successfully”.

5. Click on OK and close the window of the update tool. The 
firmware update is now completed.

http://www.gantner-instruments.com
http://www.gantner-instruments.com
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5.10.2 Firmware update for modules

Install as required the latest version of ICP 100 or test.com-
mander so that you can also install the latest version of the firm-
ware on your PC.

Procedure 1. In the program test.commander select Utilities > Module 
firmware update. 

2. Make sure that the settings with regard to the interface used 
are correct: Options > Communication settings.

3. Search for the Test Controller or the modules: Find modules.

4. If the modules are connected via a Test Controller, in the next 
window mark the Test Controller to which the modules to be 
updated are connected and click on OK.
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6 Functional Procedures

This chapter explains various important settings and processes 
more comprehensively than in the previous chapters, for exam-
ple, to provide you with decision-making aids for the interface 
parameters or the settings of the modules.

6.1 Using serial interfaces

The interface on the Q.bloxx modules is based on the RS-485 
standard. This means that data transmissions over distances up 
to 1 km and the connection of several devices to one interface is 
possible; the RS-485 interface is therefore a bus-type interface. 
With the Q.series up to 16 devices (modules) can be connected 
per bus segment.

PCs are however usually “only” equipped with one RS-232 inter-
face with which, according to the standard, a maximum line 
length of 20 m is admissible and only one device can be connected 
per interface. Therefore for communication with the Q.bloxx 
modules you need either an RS-485 interface card in the PC or an 
interface converter.

One technique is particularly important to facilitate large line 
lengths: the so-called bus termination. This comprises resis-
tances which must be connected in the lines, so that no reflec-
tions occur at the line terminations i.e. the resistances attenuate 
the signal at the end of the line.

You will find further information on these topics and on connec-
tion techniques in this section.

6.1.1 Interface converter

Gantner Instruments GmbH offers you two different interface 
converters:

1. The compact interface converter ISK 200 (bench-top unit)

The converter has an integrated power supply for the con-
nected modules and automatic baud rate detection. The 
power supply via the 230 V mains, the bus connection and the 
output voltage of 24 VDC are electrically isolated from one 

another.

2. The interface converter ISK 101

The converter is integrated directly into an interface cable. 
The terminating resistance is also located in the connecting 
plug and is always active.



Vers. No. 6.1
136 Released: 25/04/2017

6     Functional Procedures → Using serial interfaces

You can connect both converters to any “normal” RS-232 inter-
face, e.g. your PC, and then communicate with the Q.bloxx mod-
ules (UART connectors) via the RS-485 interface.

6.1.2 Bus termination on the Q.bloxx modules

To avoid signal reflections on the RS-485 interface lines each sec-
tion (bus segment) must be terminated at its physical start and 
end with a certain resistance. To achieve this, a terminating 
resistance is connected between the bus lines A (UART A) and B 
(UART B). The line A is then connected via a pull-up resistor to 
the supply voltage potential (Supply +10 to 30 VDC) and line B is 

connected to the Supply 0 V through a pull-down resistor. These 
three resistors ensure an interference-free data transmission and 
provide defined potentials (voltage levels) when no data is being 
transmitted over the bus (the interface).

The sockets on the Q.bloxx modules already have these resistors 
built in. You activate the resistors via the DIP switches 9 and 10; 
in this way both bus lines are connected to the resistance circuit.

➡ If the base is intended for accepting a Q.gate module, the termi-
nating resistances must not be activated, because this module 
contains its own resistances.

IMPORTANT
The terminating resistances may only be activated at the end 
points of the interface line (of the bus segment). If resistances are 
also activated in between, the signal is weakened and interfer-
ence or even interruption of the data transmission occurs for the 
modules located after the additional resistances.

6.1.3 Connection technology

With strong ambient interference, as is often found in industrial 
areas, we recommend screening the bus and signal lines. Gener-
ally, you should always wire the screen to the earth conductor/
housing and not to the circuit ground. If necessary, the screen 
can also be connected to the protective earth several times along 
the cable route for potential equalization. With short distances, 
e.g. stub lines, better results are often achieved when the screen 
is only connected to the end of the stub line.

With bus devices such as controllers (PLCs), computers (PCs), 
repeaters, interface converters, etc. the screen is usually realized 
by the protective conductor, in some cases using special chassis 
ground buses. Due to the screen, interference signals are 
diverted through the protective conductor before they can pene-
trate into the module. The screen on the bus cable is in this case 
connected via so-called screen terminals. Similarly, connect the 
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screen of the transducer line to the terminal with the earth sym-
bol.

6.1.4 Network topologies

For setting up networks various network structures, or so-called 
topologies, are possible. When connecting the Q.bloxx modules 
and Test Controller, a simple line or bus structure is required 
(Fig. 6-1); several “lines” can be brought together by the Test 
Controller and the UARTs present in the Test Controller (Fig. 6-
2). Other topologies, for example the tree structure (Fig. 6-3) 
used with Ethernet, are not admissible

Fig. 6-1 Line or bus structure.

Fig. 6-2 Combination of two lines on the Test Controller.

Fig. 6-3 Tree structure.
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6.2 Ethernet on the PC

The following sections describe various settings which you can 
carry out on the PC to enable a link to be formed. The images use 
menus and dialogs found in Windows 7; the names of the dialogs 
and fields in other versions of Windows are however similar and 
are usually also given.

6.2.1 Finding the IP address and subnet mask of the PC

In Windows 7 or 8 open the Network and Sharing Center, e.g. 

using  at the bottom on the right in the taskbar. Click on the 
LAN connection (the name may be different) through which the 
Test Controller is connected to the PC (Fig. 6-4 on page 139). In 
the following status dialog (similarly in Fig. 6-4) click on Details.

The current address is displayed in the next dialog under IPv4 
address.

The subnet mask determines which addresses can be reached 
from the PC: Only addresses whose figures are identical in the 
places which contain a 255 in the subnet mask can be reached. 
The IP addresses of the PC and Test Controller should normally 
be located in the same Ethernet segment (only the last group of 
figures in the IP address is different), otherwise the subnet mask 
must be 255.255.0.0 so that the last two groups of figures may be 
different.
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Fig. 6-4 Viewing/changing the IP address of the PC

Example 1 Subnet mask 255.255.255.0, IP address 192.168.100.26

Only addresses can be reached which start with 192.168.100, i.e. 
the first three groups of figures must be identical and only the 
fourth may be different.

Example 2 Subnet mask 255.255.0.0, IP address 192.168.100.26

All addresses can be reached which start with 192.168, i.e. the 
third group of figures may also be different between the PC and 
Test Controller.

6.2.2 Setting the IP address on the PC

If you want to connect to a Test Controller, you must assign a 
(temporary) IP address to the PC.
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➡ We recommend that a temporary IP address is set up on the PC, 
because then the network settings on your PC for the normal con-
nections are not changed. If you have already set up this type of 
“alternative configuration” for another network, you must note 
the existing settings so that you can restore them after conclud-
ing the configuration of modules or the Test Controller.

In Windows 7 or 8 open the Network and Sharing Center, e.g. 

using  at the bottom on the right in the taskbar. Click on the 
LAN connection (the name may be different) through which the 
Test Controller is connected to the PC (refer to Fig. 6-4 on 
page 139). In the following status dialog click on Properties 
(requires administrator rights). Then mark Internet Protocol 
Version 4 and click on Properties (refer also to Fig. 6-5).

Then proceed to the register card Alternative Configuration 
and specify an address for the PC, e.g. 192.168.100.5, and a 
subnet mask, e.g. 255.255.255.0 (Fig. 6-6).

Fig. 6-5 LAN connection properties (Windows 7 and 8)
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Fig. 6-6 Specifying the IP address and subnet mask for an alterna-
tive (temporary) configuration.

6.2.3 Allowing access to network devices (firewall)

Generally, a firewall monitoring access of the PC to the network 
and vice versa is installed on the PC. Therefore, you must allow 
access to the Test Controller or the module, otherwise no connec-
tion can be established via Ethernet. On the first attempt to 
establish a connection you receive a message similar to that 
shown in Fig. 6-7. Click on Unblock to allow the connection.

IMPORTANT
You must possess administrator rights on the PC to be able to 
unblock the connection. If this is not the case, ask your adminis-
trator to do this for you. You must enable all programs for sharing 
which use an Ethernet connection to the modules or the Test 
Controllers.
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Fig. 6-7 Windows firewall message on attempting to establish an 
Ethernet connection.
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6.3 Connecting sensors with sensing leads

Resistive sensors require an excitation voltage to be able to pro-
vide their output signal. For sensor excitation a current is passed 
through the connecting lead, which however causes a loss of volt-
age due to the resistance of the connecting lead. Consequently, 
the sensor is then not supplied with the voltage set on the ampli-
fier module, but rather with a slightly lower voltage. This leads in 
turn to a lower output signal and, depending on the cable resis-
tance, losses in the single-figure percentage range can occur 
even with just a few meters. Therefore, high quality amplifier 
modules for the excitation of resistive sensors use so-called sens-
ing leads which can measure the loss of voltage, since only a very 
small current flows in them. This is because the inputs for the 

sensing leads have very high input resistances (usually over 106 
 compared to a sensor resistance of a few 100 . The amplifier 
module can therefore acquire the voltage arriving at the sensor 
error-free and increase its excitation voltage to compensate for 
the losses in the connecting cable. This is particularly the case 
when the temperature of the connecting cable changes. In this 
case the cable resistance changes and the sensor output signal 
would therefore also change if no sensing leads were used.

We therefore recommend the use of sensing leads. This is mainly 
necessary when several meters of cable are used, low measure-
ment deviations are to be obtained or when the temperature of 
the cable may vary.
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6.4 Sensor scaling

Depending on the type of transducer (Sensor type), you have var-
ious possible scalings available. With voltage signals and strain 
gauge bridges (Bridge), you can define a conversion of the mea-
sured voltage (volts or mV/V) into a physical unit, e.g. in newtons. 
With strain gauges a special conversion tool is available to you.

Click in the column Format/balance of the variables to be set to 
call up the setup dialog (Fig. 6-8).

Fig. 6-8 Setup dialog for scaling.

6.4.1 Scaling of voltage signals and strain-gauge bridges

1. In the Unit field enter the required physical unit, e.g. N. 

If the unit has already been entered, you can select it from the 
list box.

2. Click on Scaling.

The scaling dialog is displayed.

3. Enter the transducer (sensor) data from the calibration certif-
icate or from the data sheet (example: refer to Fig. 6-9 on 
page 145).

Instead of the full scale readings in the positive and negative 
directions, you can also enter just one direction. Then in each 
case use 0 for Measurement and Displayed value at Point 
1.
An alternative is the entry of Factor and Offset if these data 
have been specified for your sensor.

The numbers in the Display field depend on the settings in 
the Range/error column.

4. Close the scaling and setup dialog with OK.
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Fig. 6-9 Scaling dialog

6.4.2 Scaling strain gauges

1. Click on Strain-gauge calculator, the unit is then automati-
cally changed to μm/m.

2. Enter the gauge factor of your strain gauge in the left field.

The gage factor is a measure of the sensitivity of the strain 
gauge and is stated on each strain-gauge pack. It is usually 
between 1.8 and 2.2. Fig. 6-10 shows scaling with k = 2.03.

3. If you are using more than one active strain gauge in your 
bridge circuit, you must also state the resulting bridge factor 
(right field). The factor depends on the orientation of the 
strain gauge on the measurement object and, where applica-
ble, also on the Poisson's ratio for the material. On a tension/
compression bar the bridge factor is, for example, approx. 
between 2.5 and 2.8 depending on the material. 

4. Close the scaling and setup dialog with OK.
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Fig. 6-10 Scaling dialog for strain gauges.
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6.5 Current measurement with an external shunt

Current measurements are carried out by measuring the voltage 
drop across a resistance of known size (shunt resistance). In the 
Q.bloxx modules, which are suitable for direct current measure-
ment, this is a resistor of 50 , with which you can measure cur-
rents up to 25 mA (the maximum shunt power dissipation is lim-
ited to 0.25 W). Higher currents need an external shunt which is 
looped into the line to be measured. The power dissipation occur-
ring at the current to be measured must be lower than the per-
missible power dissipation of the external shunt. In addition the 
voltages produced on the resistance must not exceed the permis-
sible input voltage on the analog input of the Q.bloxx module. 
Configure the analog input as a voltage input and divide the mea-
sured voltage by Rext.

IMPORTANT
The error in the current measurement using an external shunt 
depends on the accuracy of the resistor used.
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6.6 Measuring with thermocouples

Thermocouples consist of two “thermoelectric wires” which are 
formed from different materials, e.g. platinum and platinum/rho-
dium, and are joined together at one end, usually by welding. If 
this contact point and the other ends of the thermoelectric cables 
have different temperatures, a “thermoelectric voltage” is pro-
duced at the contact point. This voltage is essentially propor-
tional to the temperature difference between the contact point 
and the ends of the cables.

Since thermocouples only measure a temperature difference (dif-
ference between the temperature at the contact point and the 
measured temperature at the terminal strip on the Q.bloxx mod-
ule), the terminal temperature must be known or the “transition” 
from the thermocouple cable or compensating cable to the cop-
per cable must occur at a known temperature level. The first case 
is known as internal cold junction compensation (TCint) and the 

second case as external cold junction compensation, TCext.

To acquire the temperature with internal cold junction compen-
sation an additional temperature probe is used which measures 
the reference temperature. For the Q.bloxx modules a cold junc-
tion compensation terminal with an integrated Pt1000 tempera-
ture probe is used. In this way, the temperature at the “transition 
point” is determined and the voltage produced by the thermocou-
ple is corrected depending on the type of thermocouple.

To measure the temperature using external cold junction com-
pensation, a second thermocouple of the same type is needed 
which is connected in series with the first one. The polarity is 
chosen such that the thermoelectric voltages subtract. The sec-
ond thermocouple is located at a fixed reference temperature 
(usually 0°C). Then, the Q.bloxx module calculates the tempera-
ture at the measuring point based on the linearization curve. 
However, the Q.bloxx module requires the information of which 
reference temperature (cold point temperature) is being used.
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7 International Sales and 
Service

The current addresses of our sales partners can be found in the 
Internet on our web site. You can take up direct contact with 
Gantner Instruments GmbH at any time.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
sections are open to the public).
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